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ПРИМЕЧАНИЕ 
Экранные иллюстрации в этой публикации дают лишь примерное представление и не являются точными копиями 
экранных изображений, воспроизводимых программным обеспечением. 
 
ОГРАНИЧЕННАЯ ГАРАНТИЯ 
Фирма BERNINA International AG гарантирует, что в течение 90 дней с даты приобретения Вами программного 
обеспечения в программных продуктах не проявятся дефекты по материалам и качеству исполнения. Вам 
предоставляется исключительное право в случае обнаружения таких дефектов возвратить изделия вместе с 
доказательством покупки фирме BERNINA или уполномоченным торговым агентам в течение гарантийного срока для 
безвозмездной замены. Вы оплачиваете стоимость пересылки и страховки  и несете риск в случае повреждения и 
ошибочной адресации "продуктов ". 
Покупатель полагается на свое собственное умение и знание при выборе программного обеспечения для собственного 
использования и принимает весь риск относительно результатов применения программного обеспечения. В 
соответствии с правовыми условиями гарантии фирма BERNINA International AG не принимает на себя все другие 
гарантии и условия, которые могут быть явно выражены или подразумеваемы, включая без ограничения, гарантии и 
условия пригодности для продажи, соответствия для специфического использования и отсутствие контрафакции. 
Фирма BERNINA International AG специально не гарантирует, что программное обеспечение будет соответствовать 
всем требованиям покупателя или будет выполняться без прерываний или ошибок, в полном соответствии с описанием 
в сопровождающей документации.  
 
ОГРАНИЧЕНИЯ ОТВЕТСТВЕННОСТИ 
Фирма BERNINA International AG, ее разработчики, менеджеры, служащие или работники филиалов в соответствии с 
применимым законом, ни в коем случае не несут ответственности за любые последующие прямые или косвенные 
убытки (включая убытки от потери деловой прибыли, перерывов в работе, потери коммерческой информации и т.п.), 
возникшие в результате неправильного использования программного обеспечения или прилагаемых защитного 
устройства и кабеля, а также сопровождающей документации, независимо от обоснования требования и даже, если 
фирма BERNINA или ее уполномоченный представитель уведомлялся относительно возможности таких убытков. 
В некоторых государствах законодательство или судебная практика не допускают исключения случайных, последующих 
или специальных убытков, так что вышеупомянутое ограничение или исключение не может быть применимо к Вам. 
 
ПРЕКРАЩЕНИЕ ДЕЙСТВИЯ ЛИЦЕНЗИОННОГО СОГЛАШЕНИЯ  
Ваша Лицензия на использование программного обеспечения фирмы BERNINA действительна до тех пор, пока Вы 
выполняете условия Лицензионного соглашения. Действие Лицензии завершится автоматически без уведомления 
фирмы BERNINA International AG, если Вы будете не в состоянии выполнять любое из условий Лицензионного 
соглашения. 
Вы можете прекратить действие этой Лицензии в любое время,  возвратив программное обеспечение и все его копии 
этого, аппаратный ключ "донгл" (Dongle), кабель и всю сопровождающую документацию фирме BERNINA International 
AG.  
 
КОНТАКТНЫЕ ТЕЛЕФОНЫ 
Если у Вас возникнут любые вопросы, обращайтесь, пожалуйста, Вашему дистрибьютору фирмы BERNINA, или 
BERNINA International AG,   
CH-8280 Штеккборн/Швейцария.  
Тел.: (41)52-762 11 11  
Факс: (41)52-762 16 11 
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Глава 1 
 

Введение 
 

 
 

Приглашаем Вас ознакомиться с программным обеспечением 
BERNINA Embroidery Software – ведущим программным 
продуктом для домашнего машинного вышивания. 
Вышивальное программное обеспечение BERNINA ART Design 
является программным продуктом, основанным на 
операционной системе Windows, поэтому в нем используются 
многие команды, с которыми хорошо знакомо большинство 
пользователей персональных компьютеров. Эта программа, 
прежде всего, предназначена для изменения размеров 
вышивальных проектов и для работы со шрифтами True Type и 
является универсальным инструментом для конвертирования 
файлов вышивальных проектов. 
 

 
Первичным пользователям 
 
Если Вы впервые приобрели вышивальное ПО BERNINA, то Вам очень понравятся гибкие 
возможности ПО  BERNINA ART Design и легкость, с которой Вы сможете открыть и  редактировать 
образцы вышивки. Однако прежде чем Вы начнете работать с программой, нужно ознакомиться с 
главой Основные процедуры. Здесь Вы узнаете, как запускать приложение, открывать проект, 
распечатывать рисунки вышивок и как передать проект в вышивальный компьютер. Глава Просмотр 
и выделение проектов ознакомит Вас со способами просмотра проектов в режимах просмотра 
BERNINA ART Design.  
 
Условные, обозначения принятые в Руководстве 
 
В тексте руководства приняты следующие условные обозначения. 
 
Команды 
В этом руководстве команды меню или подменю указываются со ссылками на имена меню и команды. 
Например, команда «Show All» (Показать Все) из меню «View» (Вид) указывается как View > Show All. 
 
Диалоговые окна 
Диалоговые окна показываются в руководстве только в том случае, когда в них отображена важная 
информация для использования ПО BERNINA ART Design. Экранные иллюстрации дают лишь 
примерное представление и не являются точными копиями экранных изображений, воспроизводимых 
программным обеспечением. 
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Команды для действий мышью 
 
Указание         Символ                       Действие 
Щелчок мышью 
 
 

     Щелкнуть левой кнопкой мыши  

Щелчок правой 
кнопкой мыши 

     Щелкнуть правой кнопкой мыши  

Двойной щелчок 
 

     Дважды щелкнуть кнопкой, не 
перемещая мышь  

 
 

 
Нажмите кнопку 
ОК. 

 

Щелкнуть мышью по кнопке OK 
диалогового окна, или нажать 
клавишу Enter клавиатуры, чтобы 
завершить действие.  

 
Комбинация 
клавиш 

Описание 

[Ctrt] + [S]  Удерживая нажатой клавишу CTRL, нажать клавишу 
буквы "S" в нижнем регистре  

[Clrl] + [Shift] 
+ [H]  

Удерживая нажатой клавишу CTRL, нажать клавишу 
SHIFT и клавишу буквы "Н".  

 
Полный перечень клавиатурных команд приводится в Кратком справочном руководстве 
 
Просмотр отображаемой на экране информации 
 
Выберите Help Topics (из меню Help), чтобы просмотреть онлайновую справку. 
Выберите Online Manual (из меню Help), чтобы просмотреть онлайновое руководство. 
 
Выберите Bernina International Home Page (из меню Help), чтобы просмотреть международный сайт 
Bernina. 
 
Выберите Bernina of America Home Page (из меню Help), чтобы просмотреть сайт Bernina of America. 
 
Выберите Embroidery Onscreen (из меню Help), чтобы просмотреть сайт Embroidery Online. 
 
Экранная документация пользователя предоставляется в форме экранного руководства и экранных 
справок. 
 
Просмотр онлайновой справки (только на английском языке)  
 
Онлайновая справка обеспечивает быстрый доступ к общей информации о функциях вышивального 
ПО BERNINA ART Design и к пошаговым инструкциям. 
 
Как просмотреть онлайновую справку 
 
1 Выберите Help > Help Topics, чтобы открыть главное окно справки  Help. 
2 Нажмите кнопку Contents (Содержание), чтобы открыть главный список тем справки. Темы 

сгруппированы под заголовками высшего уровня со значками "Книга". 
3 Дважды щелкните по значку "Книга", чтобы просмотреть список тем, а затем дважды щелкните по 

выбранной теме. 
 
 
Совет: Альтернативно нажмите кнопку Find (Найти) и введите ключевое слово, чтобы найти 
интересующий вас ответ.  
 
Просмотр экранного руководства 
Вы можете прочитать экранное руководство, используя программу Adobe Acrobat™ Reader. Эта 
программа поставлена вам вместе с вышивальным ПО BERNINA. В экранном руководстве вы можете 
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быстро найти нужную вам информацию, используя стандартные функции программы Adobe Acrobat™ 
Reader. 
 
Как просмотреть экранное руководство 
 
◄ Выберите Help > Onscreen Manual. 
 

Примечание: Если программа BERNINA ART Design не запущена, вы можете открыть экранное 
руководство на английском языке непосредственно из Windows Explorer (Проводника Windows). 
Для этого найдите папку ..\Program Files\BERNINA\ART Design\bin и дважды щелкните по файлу 
UserManual.PDF. 

 
Соединение с веб-сайтами BERNINA®  
Вы можете получить доступ к информации о приобретении и поддержке программных продуктов 
непосредственно из ПО. 
 
Примечание: Вы должны иметь правильно сконфигурированный веб-браузер в своей системе 
совместно с доступом к Интернету. 
 
Как соединиться с сайтом BERNINA®  
 
◄ Соединитесь с вашим интернет-провайдером.  
◄ Выберите Help > BERNINA Web Page. 

Вы непосредственно соединитесь с домашней страницей BERNINA® по следующим адресам:  
◄ Bernina International -http://www.bernina.com/ 
◄ Bernina of America - http://www.berninausa.com/ 
◄ Embroidery Online - http: / /www. embroider yonline. com
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Глава 2 
 
 
 
 
 

Основные процедуры 
 

Для работы с программным обеспечением BERNINA ART Design 
вам требуется знать основные процедуры, такие как запуск 
программ, открытие и сохранение проектов. После запуска 
BERNINA ART Design вы должны пользоваться командами или 
пиктограммами и диалоговыми окнами, чтобы выполнять 
соответствующие задачи. Команды выбираются таким же 
образом, как и в других приложениях Windows, – из меню или 
панелей инструментов. 
В приложениях BERNINA ART Design открываются файлы в 
"родном" формате .ART, а также файлы других вышивальных 
форматов, хранящиеся на жестком диске компьютера, дискете 
или компакт-диске. 

 
Программный пакет BERNINA ART Design предлагает вам на выбор широкий диапазон 
стандартных пялец. Используйте линии сетки, чтобы точно совместить или установить 
требуемые размеры объекта вышивки.  
В этом разделе описывается, как запустить приложения BERNINA ART Design и 
соответствующие команды и инструменты. Они требуются для открытия и сохранения файлов с 
проектами. Объясняется, как активировать пяльцы и линии сетки. 

 
 
Запуск вышивального программного обеспечения BERNINA ART Design 
Software  
 

 
Для запуска BERNINA ART Design щелкните дважды мышью по этому ярлыку. 
 
 

Программа BERNINA ART Design может быть открыта через ярлык на рабочем столе или меню 
кнопки Пуск.  
 
Как запустить BERNINA ART Design 
 
◄ Щелкните дважды мышью по ярлыку BERNINA ART Design на рабочем столе Windows. 
 
Альтернативно выберите в меню кнопки Пуск > Все программы > BERNINA ART Design > BERNINA 
ART Design. 
 
BERNINA ART Design открывается с новым, пустым проектом (Design1). На показанном внизу экране 
отображены в развернутом виде все панели инструментов приложения BERNINA ART Design.  
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Design Window

 
 

Примечание: Панели являются плавающими, их можно размещать справа, слева, сверху или 
снизу и "перетаскивать" в любое место экрана. Панель Стежок и Цвет и может быть расположена 
вертикально, но в этом случае список заполняющих стежков не открываются. Поэтому 
рекомендуется размещать эту панель только горизонтально.  
 

◄ Измените окно проекта по своему желанию, при этом можно отобразить или скрыть сетку, 
изменить размеры сетки, отобразить или скрыть панели инструментов. Подробнее см. в разделе 
Отображение сетки. 

 
Совет: В строке состояния дается ценная информация по текущему проекту.   
◄ Слева отображается Prompt MessageПодсказка) с соответствующими указаниями  

 

 
◄ Индикаторы W и H показывают ширину и высоту проекта. 

 

 
◄ За ними следуют измерительные индикаторы X, Y, L и A. Подробнее см. в разделе Измерение 

расстояний на экране. 
 

 
◄ Следом за измерительными индикаторами находятся индикаторы Total Stitch Count (Общее 

количество стежков) и Zoom Factor  (Коэффициент масштаба). См. также раздел Увеличение и 
уменьшение изображения. 
 

 
 
◄ С правого края находится индикатор File Type (Тип файла). "Родные" для BERNINA ART Design 

проекты формата ART классифицированы на четыре группы в зависимости от способа создания 
файла. Подробнее см. в разделе Работа с файлами проектов. 
 

 
 
Использование команд и инструментов 
 
После запуска BERNINA ART Design вы должны пользоваться командами или ярлыками и 
диалоговыми окнами, чтобы выполнять соответствующие задачи. Команды выбираются таким же 
образом, как и в других приложениях Windows®, – из меню или панелей инструментов. Для наиболее 

Окно проекта 

Строка заголовка  
 

Строка меню 
 

Общая панель 
инструментов 

 
Панель 

инструментов 
правки 

 
Панель Стежок и 

Цвет 
 

Панель режима 
просмотра   

 
 
 
 
 
 

Строка состояния 
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Double-click
to dock

часто используемых команд имеются также клавишные комбинации быстрого вызова – клавиатурные 
команды. Подробнее см. в разделе Клавиатурные команды. 

Выбор команд с панелей инструментов 
 
Панели инструментов обеспечивают быстрый и простой доступ к командам BERNINA. Щелкните на 
кнопке инструмента, чтобы активировать команду, или, там, где это применимо, щелкните правой 
кнопкой мыши, чтобы изменить ее свойства. 
 
Как выбирать команды с панелей инструментов 
 
◄ Задержите указатель мыши на значке инструмента, чтобы увидеть его название во всплывающей 

подсказке.  

 
◄ Щелкните по значку, чтобы активировать команду. 
◄ Правой кнопкой, чтобы отрегулировать настройки или активировать вторичную команду. 

◄ Если для значка предусмотрены команды как от левой, так и от правой кнопки мыши, то ее 
название разделено косой чертой (/). Например, значок Scale by 
20% Down/Up позволяет уменьшить размер объекта на 20 %, 
если щелкнуть левой кнопкой мыши, или увеличить размер на 
20 %, если щелкнуть правой кнопкой. 

◄ Для многих инструментов щелчок правой кнопкой мыши дает 
возможность настроить текущую команду. Например, щелчок 
левой кнопкой по Show Hoops (Показать пяльцы)  показывает 
или скрывает пяльцы,  а щелчок правой дает доступ к 
диалоговому окну Options > Hoops  (Опции >  Пяльцы). 
Подробнее см. в разделе Пяльцы и сетки.  

Отмена и повторение отмененных команд 
 

 
Используйте кнопку Undo (панель General) для отмены команды. 
 
Используйте кнопку Redo (панель General) для повторения команды, которая была 
отменена. 

 
Вы можете отменить действие большинства команд. Если вы передумали, то можно снова повторить 
выполнение отмененной команды. BERNINA ART Design помнит несколько последних команд, 
которые вы назначали. 
 
Как отменить команду и снова восстановить ее действие 
◄ Для отмены команды щелкните по значку Undo. Если BERNINA ART Design больше не помнит 

выполненных команд, кнопка Undo становится блеклой.  
◄ Щелкните по значку Redo, чтобы повторить выполнение отмеченной команды. 

Перемещение и установка панелей инструментов 
 
Панели инструментов обеспечивают быстрый и простой доступ к командам BERNINA ART Design. 
Панели инструментов являются "плавающими". Это означает, что их можно перемещать по всему 
окну проекта. 
  
Как перемещать панель инструментов 
 
◄ Для перемещения панели инструментов в более 

удобное место нужно перетащить ее мышью: 
◄ Панели инструментов можно перемещать влево, 

вправо, вверх и вниз. 
◄ Они могут "плавать" в любом месте окна. 
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Native ART design

Preview on/off

 
◄ Для помещения панели в нормальное положение дважды щелкните мышью по заголовку. 
 
Работа с файлами проектов 
 
По умолчанию BERNINA ART Design сохраняет проекты в собственном ["родном"] формате файла 
.ART. Этот формат содержит всю информацию, требуемую как для вышивания проекта, так и для 
последующих изменений. В приложениях BERNINA ART Design открываются файлы в "родном" 
формате .ART, а также файлы других вышивальных форматов, хранящиеся на жестком диске 
компьютера, дискете или компакт-диске. Вы можете сохранять проекты в разных форматах ART. 

ART-файлы 
Проекты в "родном" ART-формате, называемом ‘ART Grade A’, содержат полный комплект 
информации о проекте в едином файле – очертания объекта и его свойства, фактические стежки, 
цвета ниток, пиктограмма и комментарии.  
Имеется четыре степени файлов формата ART, в зависимости от того, как был создан ART-файл, 
Grade А является наилучшим форматом, Grade В более надежен, чем Grade С, но не так хорош, как 
формат Grade А, а Grade D является наименее надежным форматом.  
Таким образом разумеется, что только проекты в формате ART Grade A содержат полный набор 
информации, требуемой для 100%-ного совершенства изменения размеров и трансформации. 
 
Источник 
файла 

Описание 

Art Grade A  

 

Файл чистого формата ART, созданный программным обеспечением 
BERNINA. Такие файлы содержат "чистые" ART объекты, контуры и 
стежки. 

Art Grade B  

 

Проекты, считанные с контурного формата, такого как GNC, и 
сохраненные как ART-файлы. Вы не можете создавать проекты формата 
Grade B в BERNINA ART Design, но если проект конвертирован в ART в 
другом программном обеспечении, BERNINA ART Design считывает его 
как проект формата Grade B. 

Art Grade C  Проекты, считанные со стежковых файлов -- SEW, PCS, PES, и др., - в 
которых стежки конвертированы в объекты.  
 

Art Grade D  Проекты, считанные со стежковых файлов -- SEW, PCS, PES, и др., - в 
которых стежки НЕ конвертированы в контуры. Подробнее см. в разделе  
 

Совет: Для информации об источниках файла проекта обратитесь к Информации о проекте (Design 
information) в диалоговом окне Open (Открыть) или Design Properties (Свойства проекта). 
Подробнее см. в разделе Просмотр информации о проекте.  

Открытие проектов 
 
Нажмите кнопку Open (панель General), чтобы открыть существующий проект. 
 

 
BERNINA ART Design открывает ряд вышивальных 
файлов не только в "родном" формате ART. 
"Родные" проекты формата ART 
классифицированы на четыре группы в 
зависимости от способа создания файла. См. 
также Запуск вышивального программного 
обеспечения BERNINA ART Design. 
 
Внимание: Вы не сможете открыть файлы ART, 
созданные более поздней версией 
программного обеспечения, если у вас запущена 
предыдущая версия. Если вы попытаетесь это 
сделать, появится указание о необходимости обновить систему до текущей версии. 
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Как открыть проект 
 
1 Нажмите кнопку Open (Открыть). Откроется  
     диалоговое окно Open. 
 
2 Выберите папку из списка Look In. 
 

Примечание: Вы можете считывать проекты, сохраняемые на дискете, компакт-диске или на 
жестком диске компьютера. 

 
3 Если проект не в формате ART, то выберите тип файла из списка Files of Type (Тип файлов). 
4 Выберите проект или проекты.  

◄ Для выбора нескольких идущих подряд проектов удерживайте нажатой клавишу Shift.  
◄ Для выбора нескольких файлов удерживайте нажатой клавишу Ctrl. 

5  Проставьте "галочку" в окошке Preview, чтобы просмотреть проект (для поддерживаемых 
форматов) вместе с данными о проекте. В эти данные входят количество стежков (S:) и цветов 
(C:), высота (H:) и ширина (W:) проекта и номер версии ПО (V:). 

6 Нажмите кнопку Open (Открыть). 
 
Примечание: Вы можете также считывать проекты из памяти вашей вышивальной машине.  
Подробнее см. в разделе Считывание проектов из машины 

Запуск новых проектов 
 
Нажмите кнопку New (панель General) для создания нового проекта с шаблоном 
NORMAL  

 
При запуске BERNINA ART Design автоматически создается новый файл - Design1. По умолчанию 
Design1 создается на основе шаблона NORMAL. Шаблоны содержат предварительно установленные 
стили, настройки по умолчанию или объекты, что ускоряет и облегчает оцифровывание. Если вы 
создаете файл, основанный на одном из шаблонов, то параметры шаблона копируются в новый 
проект.  
 
Как запустить новый проект  
 
◄ Нажмите кнопку New (Создать). 

В окне проекта откроется новый пустой проект, основанный на шаблоне NORMAL.  

Комбинирование проектов 
 
Для комбинирования проектов выберите команду Insert 
Design (меню File). 

 
BERNINA ART Design позволяет вставить один проект в другой. Два 
или больше проектов могут 
быть затем сохранены в комбинированном проекте. Если вы 
вставляете один проект в другой, две цветовые палитры 
комбинируются. Цвета с одними и теми же значениями RGB 
автоматически идентифицируются как имеющие один и тот же цвет 
ниток. Если вы 
хотите сохранить их как отдельные цвета, то вам нужно изменить 
один или другой цвет перед слиянием. 
 
Как комбинировать проекты 
 
1. Создайте или откройте первый проект. 
2. Перейдите к позиции в последовательности вышивания, в которую вы хотите вставить проект. 

Подробнее см. в разделе Обход по стежкам. 
3. Выберите File (Файл) > Insert Design (Вставить Проект). 

Откроется диалоговое окно Open. 
4. Из открывшегося списка Look In выберите папку, в которой сохраняется проект, который вы 

хотите вставить, и выберите требуемый формат из списка Files of type. 
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Format listDesign name

Current folder

5. Выберите файл с нужным вам проектом и нажмите Open.  
Проект будет вставлен в текущую позицию иглы. 

6. Переместите второй проект в нужное вам положение. 
7. Сохраните комбинированный проект под оригинальным или измененным именем. 

Вставленные вами проекты скомбинированы в единый проект 

Сохранение проектов 
 
Нажмите кнопку Save (панель General), чтобы сохранить текущий проект. 
 
 

Проекты BERNINA ART Design могут быть сохранены в чистом ART-формате. При сохранении 
проекта сохраняется имя файла, его расположение и формат и происходит его обновление в 
соответствии с выполненными изменениями.  Если вы сохраняете существующий проект под новым 
именем, в другом месте или в другом формате, вы создаете копию оригинального проекта. См. также 
раздел Передача проектов в машину. 
 
Совет: Сохраняйте свои проекты во время работы, как можно чаще. Не ждите полного завершения 
работы. Чтобы сохранить изменения в существующем файле, но оставить без изменений оригинал, 
воспользуйтесь командой Save As. Каждый раз, когда вы сохраняете проект кнопкой Save на общей 
панели инструментов, происходит обновление файла.  
 
Как сохранить проект 
1 Нажмите кнопку Save (Сохранить). 

Если вы сохраняете проект в первый раз, 
откроется диалоговое окно Save As (Сохранить 
как …). 

          
2 Из списка Save In выберите папку, в которой 

 вы хотите сохранить проект. 
3 Введите имя проекта в поле File name. 
4 Выберите формат файла из списка Save as type.   
5  Нажмите кнопку Save (Сохранить).  
 
 
Примечание: Вы можете также записывать проекты в память вашей вышивальной машине. См. 
также раздел Передача проектов в машину. 
 
Пяльцы и сетки 
 
Перед вышиванием на машине материал должен быть растянут в пяльцах. Программный пакет 
BERNINA ART Design предлагает вам на выбор широкий диапазон стандартных пялец. Используйте 
линии сетки, чтобы точно совместить или установить требуемые размеры объекта вышивки. 

Отображение пялец 
 

Для отображения пялец нажмите кнопку Show Hoop (панель General). Щелчок правой 
кнопкой мыши позволяет изменить настройки. 
 

Каждый раз, когда вы создаете новый проект, по умолчанию в окне 
проекта появляются больше пяльцы как пример пялец из тех, которые вы 
можете установить на вышивальной машине. Когда вы позиционируете 
объекты, положение пялец подгоняется автоматически, так что объекты 
всегда находятся в центре пялец. См. также раздел Закрепление 
проектов в пяльцах. 
 
Как показать пяльцы на экране 
 
◄ Нажмите кнопку Show Hoop (Показать пяльцы), чтобы отобразить 

пяльцы. 
 

◄ Нажмите еще раз кнопку Show Hoop, чтобы скрыть пяльцы. 

Папка, содержащая проект 

Имя проекта   Список  
                      форматов 
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Отображение сетки 
 

Нажимайте кнопку Show Grid (панель General) для отображения на экране или 
скрытия сетки. Щелчок правой кнопкой мыши позволяет изменить настройки 
сетки. 
 

Используйте линии сетки, чтобы точно совместить или 
установить требуемые размеры объекта вышивки. Вы 
можете показывать или скрывать сетку. 
 
Совет: Вы можете изменить интервал сетки и выбрать 
базисную точку в диалоговом окне Options. Подробнее см. в 
разделе Настройка опций сетки. 
 
Как показать сетку на экране 
◄ Нажмите кнопку Show Grid (Показать сетку), чтобы 

отобразить сетку. 
◄ Нажмите кнопку Show Grid еще раз, чтобы скрыть сетку. 

Измерение расстояний на экране 
 

Используйте команду Measure (меню View), чтобы измерить расстояние на экране. 
 
Для измерения расстояния между двумя точками на экране используйте команду Measure 
(Измерить). Эта команда отображает координаты, расстояние и угол линии от указателя мыши до 
точки, соответствующей центру пялец в пустом проекте. Результаты измерения можно видеть в 
строке состояния или в подсказке. Подробнее см. в разделе Показ /скрытие всплывающей 
подсказки измерений. 
 
Совет: Для получения более точных результатов перед измерением увеличьте изображение на 
экране. Измеряется всегда действительный размер независимо от масштаба изображения. 
 
Как измерить расстояние на экране 
 
1 Выберите View > Measure или нажмите M. 
2 Щелкните мышью по начальной точке. 
3 Удерживая кнопку мыши нажатой, переместите указатель мыши в конечную точку. 

В строке состояния появится следующая информация: 
◄ Координаты положения конечной точки (X=, Y=). 
◄ Длина измеренной линии (L=). 
◄ Угол наклона линии по отношении к горизонтали (A=). 
Результаты измерений показываются в миллиметрах или дюймах, в зависимости ль выбранной 
системы измерения в Панели управления MS Windows®. Подробнее см. в документации по 
операционной системе MS Windows®. 

Measurements
appear in tooltip
or Status line

 
Совет: Если активировано измерение длины и угла, результаты появляются также и в подсказке. 
Подробнее см. в разделе Настройка других общих опций.  

4 Нажмите Esc для завершения. 

Результаты изменения появляются как подсказка или в строке состояния 
 



Глава 3: Просмотр и выделение проектов 

BERNINA ART Design – Руководство пользователя 11

Глава 3 
 
 
 
 
 

Просмотр и выделение проектов 
 

BERNINA ART Design предоставляет несколько возможностей просматривать 
проекты вышивки, чтобы облегчить работу с ними. Увеличение масштаба изображения 
позволяет увидеть больше деталей или просмотреть проект в фактическом размере. 
Можно рассматривать существующий проект с различными цветами на разных материалах. 
Вы даже можете отображать или скрывать точки прокола иглы. 
 
 

       
 
 
 
Еще перед открытием BERNINA ART Design или своего проекта вы можете проверить номер 
версии ПО и некоторую информацию о файлах формата ART непосредственно из MS Windows® 
Explorer. Вы можете просмотреть детали вышивания проекта в диалоговом окне Design 
Properties (Свойства проекта). Важную информацию о проекте дает также функция Print 
Preview (Предварительный просмотр), включая просмотр проекта в целом, размеры проекта, 
последовательность цветов и специальные указания. 
В этом разделе разъясняются режимы просмотра проекта, предоставляемые BERNINA ART 
Design, а также различные настройки просмотра проекта. Также объясняется, как получать 
информацию о ваших проектах. 

 
Режимы просмотра 
 
BERNINA ART Design предоставляет возможность просмотра в двух режимах: 
◄ Design View (Просмотр проекта) 
◄ Artistic View (Художественный просмотр) 
 
Каждый из них доступен через панель View Mode (Режим просмотра). 

 
Режим Design View позволяет открывать и посмотреть стежки и последовательность вышивания. 
Режим Artistic View позволяет получить графическое представление о том, как должна выглядеть 
вышивка в окончательном виде. В этом режиме проект выглядит более реалистично, чем  в режиме 
Design View. В режиме Artistic View доступны все команды редактирования. 
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Как переключить на другой режим просмотра 
 
◄ Нажмите на вкладку Design View, чтобы переключить на этот режим просмотра. 

 

Design View mode Artistic View mode

 
 
◄ Нажмите на вкладку Artistic View, чтобы переключить на этот режим просмотра. 
 
Совет: Используйте режим Artistic View совместно фоном материала, чтобы увидеть, как будет 
выглядеть вышивка на выбранном материале. Подробнее см. в главе Изменение фона 

Увеличение и уменьшение изображения 
 
Щелкните по Zoom Box (панель General) для увеличения и уменьшения изображения в 
окне проекта. Используйте этот инструмент также в оконтуренных областях 
экрана. 
 
Щелкните по Show All (панель General), чтобы показать весь проект. 
 
Щелкните по Show 1:1 (панель General), чтобы показать проект в натуральную 
величину. 
 

Увеличьте изображение проекта вышивки, чтобы рассматривать индивидуальные стежки или детали, 
или уменьшите его, чтобы отобразить в окне большее количество деталей проекта. Текущий 
масштабный коэффициент показывается в нижнем правом углу экрана. См. также Клавиатурные 
команды. 
 
Примечание: Чтобы быть уверенным в том, что проект отображается на экране в правильных 
размерах, необходимо калибровать монитор. Подробнее см. в разделе Калибровка монитора. 
 
Как увеличить и уменьшить изображение на экране 
 
◄ Щелкните по значку Zoom Box или нажмите клавишу B. Указатель мыши примет вид лупы. 
◄ Щелкните правой кнопкой в окне проекта – изображение уменьшится наполовину от предыдущего 

размера, его центр будет находиться в точке щелчка.  

Right-click

 
Щелчок правой кнопкой мыши 
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Совет: В строке состояния показывается текущий "коэффициент масштабирования". Подробнее 
см. Запуск вышивального программного обеспечения BERNINA ART Design. 

◄ Щелкните левой кнопкой в окне проекта – изображение увеличится вдовое по сравнению с 
предыдущим размером, его центр будет находиться в точке щелчка.  

◄ Щелкните левой или правой кнопкой и перетащите ограничивающий прямоугольник вокруг 
масштабированной зоны. Отпустите кнопку мыши, чтобы увидеть всю масштабированную зону на 
экране. 

Drag bounding box

Zoom area

 
Выбрать и перетащить 

 
◄ Чтобы отобразить весь проект, нажмите кнопку Show All. 

Альтернативно выберите View > Show All, или нажмите 0.  
◄ Чтобы отобразить проект в натуральную величину, нажмите кнопку Zoom 1:1.  
◄ Для отображения стежков в частичном масштабе нажмите клавишу F на клавиатуре. Введите 

величину масштабирования в процентах и щелкните по OK. 

 
 
◄ Нажмите клавишу Esc, Enter или Клавишу пробела, чтобы выйти из режима Zoom. 
 

Просмотр точек прокола иглы 
 
Выберите Needle Points в меню View, чтобы показать или скрыть точки прокола иглы. 
 
В режиме Design View вы можете отображать или скрывать точки прокола иглы. Например, вы можете 
захотеть просмотреть точки прокола иглы, чтобы выбрать стежки для редактирования.  
 
Как просмотреть точки прокола иглы 
 
◄ Для просмотра точек прокола иглы выберите View (Вид) > Needle Points (Точки прокола иглы). 
 

Needle points ON

Detail showing needle points

 
   Функция Needle Points включена 
 
 

Введите масштаб 
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Просмотр последовательности вышивания отдельных фрагментов 
 
При работе с проектами вышивки вам необходимо разобраться с последовательностью 
вышивания. Вы можете проверить последовательность вышивания проекта путем ‘обхода’ по 
стежкам, цветам или объектам. Вы можете также проверить последовательность медленным 
перерисовыванием проекта на экране. BERNINA ART Design имитирует вышивание при изменении 
стежков от черного до назначенного цвета нитки, как это происходит при вышивании.  
 

Переход к начальной или конечной точке проекта 
 
◄ Для проекта нажмите клавишу Home. 

Весь проект отображается темно-серым цветом. 
 

◄ Для перехода к конечной точке проекта нажмите клавишу End. 
Весь проект отображается с выбранными цветами ниток. 

 
Используйте клавиатурные команды для быстрого обхода к начальной или конечной точке проекта. 

 
перехода к начальной точке      перехода к конечной точке 
 

Обход проекта по объектам  
Используйте клавиатурные команды для обхода проекта по объектам.  
 
◄ Для перехода к начальной точке проекта нажмите клавишу Home 
 
◄ Для перехода к следующему объекту, нажмите Ctrl + T.  
 

Travel by object

 
 
◄ Для перехода к предыдущему объекту, нажмите Shift + T. 
 

Обход проекта по цветным блокам 
 
Используйте клавиатурные команды для обхода проекта по цветным блокам.  
 
◄ Для перехода к предыдущему цвету, нажмите клавишу Page Up. 
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-1 +1

-10

+10

First color brown Second color green
 

Первый цвет – коричневый      Второй цвет – зеленый  
 
◄ Для перехода к следующему цвету, нажмите клавишу Page Down. 
 

Обход по стежкам 
Используйте клавиши со стрелками для обхода проекта по одному или по нескольким стежкам. 
Текущее положение иглы отмечается большим белым крестом, или "маркером положения иглы". 
Вначале он располагается в конечной точке проекта. При обходе по стежкам, маркер положения иглы 
соответственно перемещается. Текущий номер стежка появляется в Строке состояния. 
Подробнее см. в разделе Просмотр последовательности вышивания. 

 
 
 
 
 

 
 
 
 
 
 

 
Как обойти проект по стежкам 
1  Убедитесь в том, что функция Select Object (Выбрать объект) не  
выбрана, затем нажимайте клавиши со стрелками, чтобы обходить   
проект по одному или по десять стежков.  
◄ Нажимайте левую или правую клавишу со стрелкой, чтобы  
    обойти проект по одному стежку в обратном или прямом            
 направлении. 
◄ Нажимайте верхнюю или нижнюю клавишу со стрелкой,     
   чтобы обойти проект по десять стежков в обратном или прямом направлении. 
2  Нажимайте клавишу "+" или "-" на малой клавиатуре, чтобы обойти проект шагами по 100 
стежков. Клавишей "+" маркер перемещается в прямом направлении, клавишей "-" в 
обратном направлении. 
 

Travel backwards
one stitch

 
Переход назад на один стежок 

 
Совет: Если вы вышли за пределы видимой области, нажмите клавишу C, чтобы текущий 
стежок оказался в центре экрана. 
 

 
Белый крест – маркер текущего положения иглы 
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Просмотр всей последовательности вышивания 
 

Выберите Slow Redraw (меню View), чтобы видеть последовательность 
вышивания и цветных фрагментов проекта при замедленном перемещении. 

 
Инструмент Slow Redraw (Медленное перерисовывание) позволяет видеть последовательность 
вышивания и цветных фрагментов проекта при замедленном перемещении. 
 
Примечание: Функция Slow Redraw не может быть использована в режиме 
просмотра Artistic View. 
 
 
Как просмотреть всю последовательность вышивания 
1  В режиме просмотра Design View, выберите View > Slow Redraw или нажмите Shift+R. 

Откроется диалоговое окно Slow Redraw 

 
2  Используйте ползунок для установки скорости 
перерисовывания. 
3  Нажмите кнопку Play. 

Проект будет перерисован на экране в    
     соответствии с последовательностью вышивания.  
4  Для остановки щелкните по кнопке Stop. 

Остаток проекта перерисован. 
 
 

Обзор клавиатурных команд для просмотра последовательности вышивания 
 
Чтобы перейти ... 

 
Следует нажать

к началу проекта Home 
к концу проекта End 
на 1 стежок вперед → 
на 1 стежок назад ← 
на 10 стежков вперед ↓ 
на 10 стежков назад ↑ 
на 100 стежков вперед + * 
на 100 стежков назад - * 
к предыдущему цвету PageUp 
к следующему цвету PageDown 
к следующему 
выбранному объекту 

Ctrl + T 

к предыдущему 
выбранному объекту 

Shift + T 

* на цифровой панели, клавиша Num Lock отключена  
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Выбор объектов  

 
Щелкните по Select Object (панель Edit), если необходимо (эта кнопка активирована 
по умолчанию) и щелкните по объектам для выделения. 

 
Выберите объект, чтобы его изменить. Можно и отменить все проведенные изменения в объекте. 
 
 
Как выбирать объекты методом "указать и щелкнуть" 
1. Щелкните по Select Object (Выбрать объект).  
2. Щелкните мышью по объекту, чтобы выделить объект. 

Вокруг всего объекта появятся маркеры – манипуляторов выделения. Вы можете щелкнуть на 
любом местe в рамках выделенного объекта, чтобы перетаскивать его. 
Вокруг выделенного объекта появятся маркеры – манипуляторов выделения. 

 

 
        Объект не выделен  Выделенный объект  
 
3. Чтобы отменить выделение, нажмите ESC. 
 
 
Как отменить выделение объектов 
 
◄ Отменяйте выделения одним из следующих способов: 

◄ Нажмите Esc. 
◄ Щелкните мышью на пустом месте фона. 

 
Изменение фона 
 

Для изменения цвета фона  выберите функцию Thread Colors (меню Settings). 
 
BERNINA ART Design дает возможность выбирать цвет фона в окне проекта, чтобы согласовать его с 
цветом вашей ткани. Или же можно выбрать фон ткани для более реалистичного вида и 
воспроизведения. Фон сохраняется вместе с проектом. 

 
Белый фон    Желтый фон  

 
Как изменить цвет фона 
 
1 Выберите Settings (Настройки) > Thread Colors (Цвет ниток). 

Откроется диалоговое окно Design Properties  > Thread Colors.  
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Дважды щелкните, чтобы изменить фон 

 
 

2 Выберите BGK из списка. 
3 Щелкните  по Edit или щелкните дважды по BGK. 
 
Откроется диалоговое окно.  
 

Click to select
new color

 
4 Щелкните  по Edit. 
5 Выберите цвет из диалогового окна Color (Цвет). 

 

 
 
6 Нажмите кнопку ОК. Фон сохраняется вместе с проектом. 

 
Просмотр информации о проекте 
 
BERNINA ART Design предоставляет информацию о проектах разнообразными способами и в разных 
форматах. Еще перед открытием BERNINA ART Design или своего проекта вы можете посмотреть 
номер версии ПО и проверить некоторую информацию о файлах формата ART непосредственно из 
MS Windows® Explorer. Вы можете просмотреть детали вышивания в диалоговом окне Design 
Properties (Свойства проекта). Важную информацию о проекте дает функция Print Preview 
(Предварительный просмотр), включая просмотр проекта в целом, размеры проекта, 
последовательность цветов и специальные указания. 
 

Просмотр свойств проекта 
 

Используйте функцию Design Properties (меню File), чтобы увидеть детали вышивания 
проекта. 

 
В диалоговом окне Design Properties (Свойства проекта) вы можете проверить номер версии 
программного обеспечения и другую информацию. Приводятся также детали вышивания. 
Большинство данных в этих полях не подлежат непосредственному изменению. 
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Как просмотреть свойства проекта 
 
1 Выберите File > Design Properties. 

Откроется вкладка Design диалогового окна Design Properties . 
 

На этой вкладке содержится информация о 
высоте и ширине проекта, количестве стежков и 
цветов. Эти данные извлечены из проекта и не 
могут быть изменены.  
 

2 Выберите закладку Summary, чтобы увидеть 
или ввести информацию о проекте. 

 

 
3 Щелкните на поле и введите любой текст, который поможет вам впоследствии идентифицировать 

проект. 
 

Примечание: Информация из этой вкладки включена в окно Предварительного просмотра, а 
также во вкладку Summary диалогового окна Windows Properties. Подробнее см. в разделе  
Предварительный просмотр проектов.  
 

4 Нажмите кнопку OK. 
 
 

Предварительный просмотр проектов 
 
Нажмите кнопку Print Preview (панель General), чтобы увидеть на экране проект в том виде, в котором 
он может быть распечатан. 
 
Функция Print Preview (Предварительный просмотр) позволяет получить важную информацию о 
проекте, включая просмотр проекта в целом, размеры проекта, последовательность цветов и 
специальные указания. См. также раздел Распечатка проектов. 
 
Как предварительно просмотреть проект 
 
1 Нажмите кнопку Print Preview (Предварительный просмотр). 

В окне предварительного просмотра появится изображение проекта. 
Щелкните ‘Print Now’, чтобы распечатать проект   
Нажмите ‘Two Page’, чтобы показать одну или две страницы    
Щелкните ‘Option’, чтобы настроить опции печати 
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Щелкните, чтобы распечатать проект 
Нажмите, чтобы показать одну или две страницы 

Щелкните, чтобы настроить опции печати 

            
Design Design information

 
2 Настройте требуемый вид изображения: 

◄ Для изменения ориентации на бумаге выберите Landscape (Альбомная) или Portrait 
(Портрет).  

◄ Для изменения отображаемой информации и установки требуемых опций печати выберите 
Options. См. также Настройка опций печати вышивальных файлов.  

◄ Нажмите Zoom In, чтобы прочитать информацию о проекте или более подробно просмотреть 
проект. Большие проекты могут быть отображены на нескольких страницах. 

◄ Чтобы распечатать проект, нажмите Print.  
◄ Чтобы закрыть окно предварительного просмотра, нажмите Close.
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Глава 4 

 
 

Закрепление проектов в пяльцах 
 

Перед вышиванием на машине материал должен быть растянут в пяльцах. Программный пакет 
BERNINA ART Design предлагает вам на выбор широкий диапазон стандартных пялец. Если в 
ваш проект входит крупный объект или большое количество небольших объектов, вам может 
потребоваться использовать технику перезаправки пялец.  Если у вас есть пяльцы, которых нет 
в списке, вы можете определить собственные пяльцы по своему эскизу или на основе 
стандартных пялец. См. также Отображение пялец. 
 

 
 

В этом разделе описывается, как выбирать и отображать пяльцы в программах BERNINA 
Embroidery Software. Объясняется, как создавать и модифицировать пользовательские пяльцы. 
Также даются указания, как закреплять в пяльцах крупные проекты. 

 
Выбор пялец 
 
Каждый раз, когда вы создаете новый проект, по умолчанию в середине окна проекта появляются 
пяльцы, которые вы установили на вышивальной машине. Когда вы позиционируете объекты, 
положение пялец подгоняется автоматически так, чтобы объекты всегда находятся в центре пялец. 
Инструмент Show Hoop позволяет отображать или скрывать пяльцы. Диапазон размеров пялец дает 
возможность широкого выбора типов проекта. 
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Изменение пялец 
 
Щелкайте по кнопке Show Hoop (панель General), чтобы включить или отключить 
показ пялец. Щелчок правой кнопкой мыши позволяет 
изменить настройки пялец. 

 
Из предоставляемого вам списка пялец с разными размерами выберите 
наименьшие пяльцы, которые подходят к вашему проекту.  Благодаря 
этому ткань во время вышивания будет оставаться плотно натянутой. 
См. также Закрепление в пяльцах крупных проектов.  
 
Примечание: Когда вы выбираете новые пяльцы, они становятся 
"текущими" до тех пор, пока не будут изменены в текущей или 
последующей сессии. 
 
Как изменять пяльцы 
 
1  Щелкните правой кнопкой по значку Show Hoop или выберите  View 

> Hoop. 
 Появится диалоговое окно Options> Hoop.  
 

 
2  Выберите пяльцы из списка Hoop. 
3  Если требуется поместить важную часть проекта в определенной части пялец, выберите опцию 

Manual и опцию Set Hoop Center (Установить центр пялец). 
4.  Щелкните по OK. 
 Если вы выбрали опцию Set Hoop Center, щелкните в окне проекта, в том месте, где вы хотите 

поместить центр пялец. 
 

Настройка центра пялец 
 
Щелкайте по кнопке Show Hoop (панель 
General), чтобы включить или отключить 
показ пялец. Щелчок правой кнопкой мыши  
позволяет изменить настройки пялец. 

 
По умолчанию BERNINA всегда размещает проект в 

центре пялец. Однако вы можете выбрать опцию Manual, 
если вы хотите поместить проект в другой части пялец. Вы 
можете также изменить положение центра пялец.     
 

Выберите 
требуемый 
размер пялец 

Автоматическая центровка Вручную 
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H

Как настроить центр пялец 
 
1 Щелкните правой кнопкой по значку Show Hoop или выберите  

 View > Hoop.  
 Появится диалоговое окно Options> Hoop.  
 
 
 
 
 
 
2 На настроечной панели Position выберите способ центровки пялец. 
 
◄  Automatic Centering (Автоматическая центровка): пяльцы 
перемещаются таким образом, что проект всегда находится в 
центре. 
 
 
 
 
 
 
 
 
 
◄  Manual (Ручная): пяльцы остаются в своем первоначальном 

положении. 
 Выберите Set Hoop Center (Установить центр пялец), чтобы 

изменить положение пялец. 
 
 
3 Щелкните по OK. 
 Если вы выбрали опцию Set Hoop Center, щелкните в окне 

проекта, в том месте, где вы хотите поместить центр пялец. 
 
 
Определение пользовательских пялец  
 
Если вы используете пяльцы с отсутствующими в списке размерами, вы можете назначить свои 
собственные пяльцы и сохранить их для последующего использования. Вы можете создавать или 
редактировать четыре типа пялец – прямоугольные, овальные, раздвижные и 3-позиционные. 
 

Назначение прямоугольных пялец 
 
Щелкайте по кнопке Show Hoop (панель General), чтобы включить или отключить 
показ пялец. Щелчок правой кнопкой – создание пялец. 

 
Прямоугольные пяльцы отображаются черными пунктирными линиями. Вы можете назначить высоту 
и ширину прямоугольника в соответствии с размерами пялец. 
 
     Ширина 

 
 
 
 

 
 
 

 
 
 

Высота 
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My rectangle hoop

T

Width

 
Как назначить прямоугольные пяльцы 
 
1 Щелкните правой кнопкой по значку Show Hoop или 

выберите  View > Hoop. 
 
Появится диалоговое окно Options> Hoop.  
 
 
 
 
 
 
2   Нажмите кнопку New Hoop. 

Откроется диалоговое окно Create/Edit Hoop 
(Создать/Редактировать пяльцы). 
 

 
3 В списке Format выберите Rectangle.  
 
4  В панели Dimensions (Размеры) введите высоту 

(Height) и ширину (Width) прямоугольных пялец. 
 
5  Нажмите кнопку Save Hoop As (Сохранить пяльцы 

как) Откроется диалоговое окно Save Hoop As. 
 
 

6 Введите название пялец. 
 
 
7 Щелкните по OK и Save Hoop. 
 
 

Назначение овальных пялец 
 
Щелкайте по кнопке Show Hoop (панель General), чтобы включить или отключить 
показ пялец. Щелчок правой кнопкой – создание пялец. 
 

Овальные пяльцы отображаются черным пунктирным контуром. Вы можете назначить высоту и 
ширину овала в соответствии с размерами пялец. 
 

             
 
 
 

 
Общая высота 

 
 

 
 
 
                           Ширина 

 
Как назначить овальные пяльцы 
 
1 Щелкните правой кнопкой по значку Show Hoop или выберите  

View > Hoop.  
 Появится диалоговое окно Options> Hoop.  
2  Нажмите кнопку New Hoop. 

Высота  
прямоугольника 
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Width

 
Откроется диалоговое окно Create/Edit Hoop 
(Создать/Редактировать пяльцы). 
 

3 В списке Format выберите Oval. 
4 На панели Dimensions введите высоту 

прямоугольника (Rectangle Height), общую высоту 
(Total Height) и ширину (Width) овальных пялец. 

5 Нажмите кнопку Save Hoop As (Сохранить пяльцы 
как)  

 Откроется диалоговое окно Save Hoop As. 
6 Введите название пялец. 

My oval hoop

 
7 Щелкните по OK и Save Hoop. 

 
 

Назначение раздвижных пялец 
 
Щелкайте по кнопке Show Hoop (панель General), чтобы включить или отключить 
показ пялец. Щелчок правой кнопкой – создание пялец. 
 

Раздвижные пяльцы являются специальными пяльцами с регулируемыми рамками для 
приспособления к необычным размерам проекта. Вы можете назначить высоту и ширину пялец, а 
также поля вышивания в соответствии с размерами используемых пялец. 
 
 
 
 
 
Поле  
вышивания 

                                                  Общая высота 
 
 
 
 
 
 
                  Ширина 

 
Как назначить раздвижные пяльцы 
 
1 Щелкните правой кнопкой по значку Show Hoop или 

выберите  View > Hoop.  
Появится диалоговое окно Options > Hoop.  

 
 
2 Нажмите кнопку New Hoop. 
 

Откроется диалоговое окно Create/Edit Hoop.  
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3  В списке Format выберите Sliding (Раздвижные). 
4 В панели Dimensions (Размеры) введите высоту 

поля вышивания (Sewing Field), общую высоту (Total 
Height) и ширину (Width) пялец. 

 
Примечание: Лучше всего вводить в первую очередь 
общую высоту. Если поле вышивания больше 
принятой по умолчанию общей высоты, то 
установленный размер уменьшается. 

5 Нажмите кнопку Save Hoop As (Сохранить пяльцы 
как). Откроется диалоговое окно Save Hoop As. 

6  Введите название пялец. 
 

My sliding hoop

 
 
7 Щелкните по OK и Save Hoop. 
 

Назначение 3-позиционных пялец 

Щелкайте по кнопке Show Hoop (панель General), чтобы включить или отключить 
показ пялец. Щелчок правой кнопкой – создание пялец. 
 

3-позиционные пяльцы позволяют вручную разделять крупные проекты и вышивать без обычных 
проблем регистрации. 
 В отличие от раздвижных пялец поля вышивания находятся в фиксированной позиции с известными 
размерами, что облегчает регистрацию объектов, вышиваемых в каждой позиции. На экране они 
отображаются в виде трех оконтуренных пунктиром прямоугольников. Верхний прямоугольник 
зеленый, средний синий и нижний красный. Вы можете назначить собственные 3-позиционные 
пяльцы в соответствии с размерами используемых вами пялец. 
 
Высота 1-й позиции 
 
Высота 2-й позиции 
 
Высота 3-й позиции      Общая высота 

  
 
 
 
 
 
 
                                                                 
                                           Ширина 

 
Как назначить 3-позиционные пяльцы 
1 Щелкните правой кнопкой по значку Show Hoop или 

выберите  View > Hoop.  
 Появится диалоговое окно Options> Hoop.  
2  Нажмите кнопку New Hoop.  
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Откроется диалоговое окно Create/Edit Hoop (Создать/Редактировать пяльцы). 
 
 
3  В списке Format выберите 3-Position (3-

позиционные). 
4 В панели Dimensions (Размеры) введите общую 

высоту (Total Height), значения высоты для позиций 
     1, 2 и 3, а затем ширину пялец (Width). 
 

Примечание: Лучше всего вводить в первую очередь 
общую высоту. Если поле вышивания больше 
принятой по умолчанию общей высоты, то 
установленный размер уменьшается. 

5  Нажмите кнопку Save Hoop As (Сохранить пяльцы 
как). Откроется диалоговое окно Save Hoop As. 

6 Введите название пялец. 

My 3 position hoop

 
7 Щелкните по OK и Save Hoop. 
 
 
Изменение настроек собственных пялец 
 

Щелкайте по кнопке Show Hoop (панель General), чтобы включить или отключить 
показ пялец. Щелчок правой кнопкой – редактирование пялец. 
 

Вы можете при необходимости изменять высоту и ширину новых пялец. 
 
 
Как изменять настройки пялец 
1 Щелкните правой кнопкой по значку Show Hoop или 

выберите  View > Hoop.  
Появится диалоговое окно Options > Hoop.  

 
 
 
Примечание: Чтобы удалить пяльцы, нажмите кнопку Delete 
Hoop (Удалить пяльцы), а затем для подтверждения  
кнопку OK. Пяльцы будут безвозвратно удалены. 
 
 
 
 
2 В списке Hoop (Пяльцы) выберите пяльцы. 
3 Нажмите кнопку Edit Hoop (Редактировать пяльцы).  

Откроется диалоговое окно Create/Edit Hoop. 
 
 
4 Введите новые размеры. 
 
 
5  Нажмите кнопку Save Hoop (Сохранить пяльцы). 
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n

Start Point: Auto Start
End Point: Auto End,
Center of the design

End Point:
Digitized

Start Point:
Digitized

Настройка автоматических начальных и конечных точек 
 

Используйте команду Start and End (меню Arrange), чтобы установить начальную и 
конечную точки проекта. 

 
Перед вышиванием некоторые вышивальные машины потребуют от вас точно позиционировать иглу 
в месте первого прокола материала иглой. Это облегчит позиционирование иглы перед вышиванием 
и предотвращает возможность выхода иглы за пределы пялец. 
Используйте команду Start and End (Начало и Конец), чтобы определить первый и конечный стежки 
проекта. 
 
Как настроить автоматические начальные и конечные точки 
1  Выберите команду Arrange > Start and End. 
   Откроется диалоговое окно Start and End. 
 
 
 
2  Выберите метод Start Needle Position (Начальная точка  
    иглы) 
◄ First Stitch of Design (Первый стежок): начальная точка    
     является первым стежком проекта. 
◄ Auto Start at (Автоматическая начальная точка в): Maintain      
     Automatically (Поддерживать автоматически): начальная точка 
     автоматически устанавливается с назначенной точки проекта       

     - выберите из возможных   
       вариантов:  
 
 
 
 
 
 
 ◄ 
Digitize Start Needle Position (Определить 
начальную точку): вам будет предложено ввести 
начальную и конечную точку. 
 
 
3  Выберите метод End Needle Position (Конечная 
точка) 

◄ Last Stitch of Design (Последний стежок): 
последняя точка является последним стежком 
проекта. 
◄ Auto End at (Автоматическая последняя 

точка в): Maintain Automatically (Поддерживать 
автоматически): последняя точка автоматически 
устанавливается с назначенной точки проекта - 
Return to Start (Возврат к начальной точке), 
Center of Design (Центр проекта) или Bottom 
Middle (Середина нижней части). 
◄ Digitize End Needle Position (Определить конечную точку): вам будет предложено ввести 
конечную точку. 

 
4  Проставьте флажок в Maintain Automatically (настройка по умолчанию), чтобы автоматически 
поддерживать начальную и/или конечную позицию иглы. 
 
5  Щелкните по ОК. 
Соединительные стежки будут вставлены по необходимости перед первым и после последнего 
стежка проекта. 

Выберите метод 
начальной точки 
иглы 
 
 
 
 
Выберите метод 
конечной точки 
иглы

Начальная точка:     Начальная точка:  
Auto Start                                   Первый стежок: 
Конечная точка:Auto End,  Конечная точка: 
центр проекта      Последний стежок 
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Глава 5 

 
 
 
 
 
 
 
 

Цвета ниток и таблицы ниток 
 

После оцифровывания Вашего проекта цвета ниток из палитры цветов были выбраны для 
каждого объекта. Цветовая палитра содержит набор цветов ниток, специальный для каждого 
проекта. Эта цветовая схема представляет собой фактические цвета ниток, с которыми будет 
вышит проект. 

 
Есть возможность предварительно посмотреть проект в разных цветах и на разных фонах. 
Можно и распечатать цветовые схемы и фон проекта с помощью функции предварительный 
просмотр печати. 
 
Для каждой цветовой схемы вы можете выбрать цвета из фирменных таблиц ниток, 
содержащих диапазон цветов, от различных производителей ниток или создать свою цветовую 
схему. Для экономии времени при настройке новых цветовых схем вы можете создать 
собственные таблицы ниток, используя наиболее части применяемые цвета. Вы можете 
добавлять, редактировать и удалять нитки из таблицы ниток или переименовывать или удалять 
сами таблицы. В BERNINA ART Design вы можете искать нужные вам нитки по различным 
критериям. 
 
В этом разделе описывается, как выбирать цвета из цветовой палитры. Здесь также 
поясняется, как определять свои собственные цвета ниток и таблицы. 
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Подбор цветов ниток 
 
В BERNINA ART Design вы можете вручную найти нужные вам нитки по различным критериям. 
Приведение в соответствие цвета нитки позволит вам найти и изменить цвет нитки, основанный на 
близком соответствии с одной или несколькими таблицами ниток. 
 

Поиск типов ниток 
 

Для поиска нитки выберите Thread Colors из меню Settings. 
 
Вы можете найти нитку по коду или описанию в диалоговом окне Thread Colors (Цвета ниток). 
 
Как найти тип нитки 
 
1 Выберите Settings (Настройки) > Thread Colors (Цвета ниток) 
Откроется закладка Thread Colors диалогового окна Design Properties (Свойства проекта). 
 
 
 
 
2  Выберите таблицу ниток, чтобы включить в поиск из списка  
   Thread Charts (Таблицы ниток). 
3  Выберите функцию поиска – Code (Код) или Description 
   (Описание).   Код – это идентификационный  
   номер цвета нитки в бренде. 
4  В поле Search (Поиск) введите первые  
   несколько символов требуемого кода или  
   описания. 
   Система разыщет наиболее близкое  
   соответствие и отобразит его в списке цветов  
   нитки. 
 
 
 

Выбор кода нитки 
 

Подбор ниток из различных таблиц 
 

Для подбора ниток из различных таблиц выберите Thread Colors (меню Settings). 
 
Вы можете подбирать и изменить цвет нитки, основанный на близком соответствии с одной или 
несколькими таблицами ниток. 
Вы можете также использовать этот метод для изменения цвета всех объектов. Например, изменить 
светло-зеленый цвет всех объектов на темно-зеленый цвет. 
 
Как подбирать нитки из различных таблиц 
1  Выберите Settings (Настройки) > Thread Colors 
   (Цвета ниток). 
   Откроется закладка Thread Colors 
    диалогового окна Design Properties  
   (Свойства проекта).             
 
2  Выберите цвет для подбора. 
3  Выберите наиболее подходящий    
   цвет нитки и щелкните по Assign,  
   чтобы добавить его  в таблицу цветов.  
4  Повторяйте эту операцию до тех пор,  
    пока не будут подобраны все цвета, которые вы хотите 
    использовать в проекте. 
 

 
Выбор таблицы 

ниток 
 
 

Подбор кода 
 

Ввод поисковой 
строки 

Выбор цвета 
для подбора 

 
 

Выбор таблицы 
ниток 

 
Выберите цвет для 
подбора из списка 
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Оригинальные   Красный цвет      Коричневый цвет  
цвета проекта   заменен желтым     заменен зеленым 
 
5  Щелкните по OK, 
 
 
Создание собственных таблиц ниток 
 

Для создания новых таблиц ниток выберите Thread Colors (меню Settings). 
 
Таблицы ниток – это списки предварительно определенных цветов ниток. Они могут быть основаны 
на фирменных таблицах ниток или на составленных вами таблицах. 
 

Создание новых таблиц ниток 
При создании таблицы ниток вы создаете набор цветов для использования в вашем проекте. 
 
Как создать таблицу ниток 
1  Выберите Settings (Настройки) > Thread Colors (Цвета ниток). 
    Откроется закладка Thread Colors диалогового окна Design Properties (Свойства проекта). 
 

C
c

 
2  Щелкните по Modify Charts (Изменить таблицы). 
    Откроется диалоговое окно Modify Thread Chart  
   (Изменение таблицы ниток). 
 
3  Щелкните по New (Новый). 
    Откроется диалоговое окно New Thread Chart (Новая  
    таблица ниток). 
 

Enter name for
chart

 
 
4   Введите имя таблицы и нажмите OK. 
 
Примечание: При присвоении имени для ваших собственных цветовых таблиц или 
отредактированных цветовых таблиц не используйте символы или знаки препинания, такие как 
запятые.  
Вы возвратитесь к диалоговому окну Modify Thread Chart. Новая таблица создана и готова для 
добавления цветов ниток. 
 
5  Щелкните по Add (Добавить), чтобы открыть окно Add     
   Thread (Добавить нитку). 
   Подробнее см. в разделе Добавление собственных   
     цветов  в  таблицу ниток. 
6  Щелкните по Copy From (Скопировать из), чтобы добавить  
    цвета из существующей таблицы. 
    Подробнее см. в разделе Копирование цветов из таблицы в таблицу. 
7  Щелкните по ОК. Новая таблица создана и готова для использования. 

Нажмите по Create/Modify для создания 
собственной таблицы ниток 

Нажмите New 
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Копирование цветов ниток из таблицы в таблицу 
 
Вы можете копировать цвета ниток  из одной таблицы в другую для создания собственных таблиц из 
существующих цветов. 
 
Как копировать цвета ниток из таблицы в таблицу 
1  Откройте диалоговое окно Modify Thread Chart (Изменение таблицы ниток). 
    Подробнее см. в разделе Создание новых таблиц ниток. 

Выбор таблицы ниток 

 
                               Нажмите Copy From 
 
2  Выберите таблицу из списка Thread Chart (Таблица  
   ниток) > Name (Имя) 
3  Щелкните по Copy From… (Скопировать из …) 
    Откроется диалоговое окно Copy From. 
4  Из списка Name выберите таблицу ниток, содержащий 
    цвет, который вы хотите копировать. 
5  Выберите цвет, который вы хотите копировать и  
    нажмите OK. 
    Цвет ниток будет скопирован в другую таблицу ниток и появится в конце списка. 
 

Добавление собственных цветов в таблицу ниток 
 
Вы можете добавлять цвета в таблицы ниток из других таблиц или самостоятельно смешанных 
цветов, 
 
Как добавить собственные цвета в таблицу ниток 
1  Откройте диалоговое окно Modify Thread Chart (Изменение таблицы ниток). 
    Подробнее см. в разделе Создание новых таблиц ниток. 
2  Щелкните по Add, чтобы добавить собственные цвета. 
    Откроется диалоговое окно Add Thread (Добавить нитку). 
3  Смешайте отображаемый цвет нитки. 
    Подробнее см. в разделе Смешивание ваших собственных таблиц ниток. 
4  Введите код, бренд и опишите детали для нового цвета нитки. 

  Код – это идентификационный номер цвета нитки в бренде. 
5  Щелкните по ОК. 
    Новый цвет появится в списке Threads (Нитки). 
 

Создание ваших собственных цветов ниток 
 
Вы можете изменить цвет, который отображается для выбранной нитки или создать новые цвета 
ниток, используя диалоговое окно Color (Цвет). 
 
Как создавать ваши собственные цвета ниток 
1  В диалоговом окне Add Thread (Добавить нитку) или Edit Thread (Редактировать нитку).  
  щелкните по Mix (Смешать). 
◄ Подробнее см. в разделе Изменение характеристик нитки. 
◄ Подробнее см. в разделе Добавление собственных цветов в таблицу ниток.. 
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Откроется окно Color (Цвет).. 
 
2  Из таблицы Basic colors (Основные цвета) выберите цвет, 
    который ближе всего подходит к нужному вам цвету. 
3  Щелкните мышью и перетащите крестик по  
    спектру цветов, чтобы получить требуемый вам цвет. 
4  Передвиньте ползунок на правой стороне окна цветового  
    спектра, чтобы отрегулировать яркость цвета. 

В правом нижнем углу диалогового окна Color появятся 
значения HLS (Цвет-Яркость-Насыщенность) и RGB 
(Зеленый, Красный, Синий). Введите эти значения для 
точного определения цветов. 

5   После создания (смешивания) требуемого цвета Щелкните по Add to Custom Colors (Добавить к 
     пользовательским цветам). 
6   Щелкните по ОК. 
     Новый цвет появится в окне просмотра Color (Цвет). 
 
Изменение таблиц ниток 
 
Обновление существующих таблиц ниток путем изменения характеристик ниток или удаления 
отдельных ниток. Вы можете также переименовывать или удалять таблицы ниток. 
 

Изменение характеристик нитки 
Изменение кода, бренда или описания существующей нитки. 
 
Как изменить характеристики нитки 
1 Откройте диалоговое окно Modify Thread Chart. Подорбнее см. в разделе Создание собственных 
таблиц ниток. 
 
 
2  Из списка Name (Имя) выберите  
   таблицу для изменения. 
3  Из списка Threads (Нитки)  
    выберите нитку для изменения. 
4  Щелкните по Edit (Редактировать). 
    Откроется диалоговое окно Edit  
    Thread (Редактировать нитку). 
5  Скорректируйте при необходимости код, бренд и детали  
    описания для цвета нитки. 

Код – это идентификационный номер цвета нитки в бренде. 
Подробнее см. в разделе Добавление собственных цветов в таблицу ниток. 

6  Щелкните по ОК. 
 
 

Удаление ниток из таблиц 
 

Для удаления ниток из таблиц выберите Thread Colors (меню Settings). 
 
Вы можете легко удалить ненужные цветные нитки из таблицы ниток, используя диалоговое окно 
Modify Charts (Изменить таблицы). 
 
Как удалять нитки из таблиц 
1  Откройте диалоговое окно Modify Thread  
Chart (Изменение таблицы ниток). 
Подробнее см. в разделе Изменение 
таблиц ниток. 
 
2  Из списка Name (Имя) выберите таблицу 
для изменения. 

 
 
Нажмите для удаления  
выбранного цвета 
 
Нажмите для удаления  
всех цветов 
 

Выберите таблицу 
ниток

 
Выберите цвет для 

изменения 
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3  Из списка Threads (Нитки) выберите нитку (или нитки) для удаления. 
4  Щелкните по Remove (Удалить). 
Появится требование подтвердить удаление. 
5  Нажмите Yes (Да). 
Совет: Для удаления всех ниток из таблицы. Щелкните по Clear All (Удалить все). 

Переименование таблиц ниток 
 
Для переименования таблиц ниток выберите Thread Colors (меню Settings). 

 
Для переименования таблиц ниток используйте диалоговое окно Modify Thread Chart (Изменение 
таблицы ниток). 
 
Совет: Выбирайте имена, которые помогут вам вспомнить, какая таблица вам требуется, или таким 
образом, чтобы наиболее часто используемые таблицы находились в верхней части списка. 
 
Как переименовывать таблицы ниток 
1  Откройте диалоговое окно Modify Thread Chart (Изменение таблицы ниток). 
Подробнее см. в разделе Изменение характеристик нитки. 
 

 
Выбор таблицы ниток   Нажать для изменения имени 

 
2  Из списка Name (Имя) выберите таблицу для изменения. 
3  Щелкните по Rename (Переименовать). 
Откроется диалоговое окно Rename Thread Chart (Переименовать таблицу ниток). 
 
 
 
Измените имя таблицы  
 
4  Введите новое имя для таблицы ниток, затем нажмите ОК. 
 
 
Удаление таблиц ниток 

 
Для удаления таблиц ниток выберите Thread Colors (меню Settings). 

 
Для удаления ненужных таблиц ниток используйте диалоговое окно Modify Thread Chart (Изменение 
таблицы ниток). 
 
Примечание: Соблюдайте осторожность при удалении таблиц ниток. Если вы удалите по ошибке 
нужную таблицу, то вам потребуется перезапустить BERNINA ART Design, чтобы восстановить ее. 
 
Как удалять таблицы ниток 
1  Откройте диалоговое окно Modify Thread Chart (Изменение таблицы ниток). 
    Подробнее см. в разделе Изменение таблиц ниток. 
 

 
                Выбор таблицы ниток    Нажать для удаления выбранной таблицы 
 
2  Из списка Name (Имя) выберите таблицу для удаления. 
3  Щелкните по Delete (Удалить). 
    Появится требование подтвердить удаление. 
4   Нажмите Yes (Да). 
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Глава 6 

 
Расположение и трансформация 
вышивальных проектов 
 

 
BERNINA ART Design позволяет изменять позицию, размер и ориентацию вышивальных 
проектов  путем перетаскиванием мышью, масштабированием и транспормацией.  
Модифицировать проекты  можно непосредственно на экране.  
 

 

        
В этом разделе описывается, как позиционировать вышивальные проекты. Также 
рассматриваются способы изменения размеров, вращения и перекоса проектов. 
 

Примечание: Возможность изменения размера и качество вышивки в конечном счете зависит от 
формата первоисточника – ART Grade A, ART Grade B, ART Grade C или ART Grade D. Только 
проекты в "родном" формате ART Grade A содержат полный набор информации, требуемой для 
100%-ного совершенства масштабирования и трансформации. 
 
Позиционирование проектов 
 

 Щелкните по Select Object (панель Edit), если необходимо (эта кнопка активирована по 
умолчанию) и щелкните по проектам для выделения. 

 
Для позиционирования проекта перетаскивайте его мышью. Используйте клавиши со стрелками для 
"подталкивания" проекта к нужной позиции. 
 
Как позиционировать проект 
1  Выберите объект/ы для перемещения. Подробнее см. в разделе  Просмотр и выделение 
проектов. 
2  Перетащите мышью объект в новое положение. 
 

Курсор в виде перекрести в центре объекта 
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3  Для более точного позиционирования нажимайте клавиши со стрелками, чтобы "подтолкнуть" 
объект к требуемой позиции. 

Совет: Увеличьте масштаб изображения, чтобы было легче выполнять малейшие перемещения. 
Размеры объекта на экране изменяются в зависимости от текущего масштаба. Чем больше масштаб, 
тем на меньшее расстояние можно перемещать объект. 
 
Изменение размеров проектов 
 
Вы можете изменять размеры проекта  путем перетаскивания меток – манипуляторов выделения 
мышью. При изменении размеров проекта изменяется количество стежков для сохранения интервала 
между стежками. 
 
Примечание: Только проекты в "родном" формате ART Grade A содержат полный набор 
информации, требуемой для 100%-ного совершенства масштабирования и трансформации.  
 
Изменение размеров объектов инструментом Scale by 20% Down/Up 
 

 Щелкните по значку Scale by 20% Down/Up (панель Edit), чтобы изменить размеры 
проекта  на 20 %.   

 
Используйте эту технику, если вы хотите быстро выполнить изменения, которые не требуют особой 
точности. 

                  

Original design

Scaled up 20%

Scaled down
20%

 
уменьшение на 20 % оригинальный размер увеличение на 20 % 

 
Как изменять размеры объектов инструментом Scale by 20% Down/Up 
1  Выделите проект. 
2  Щелкните по значку Scale by 20% Down/Up. 

◄ Щелкните левой кнопкой мыши, чтобы уменьшить проект на 20 %. 
◄ Щелкните правой кнопкой мыши, чтобы увеличить проект на 20 %.  

Изменение размеров объектов перетаскиванием мышью 
 

 Щелкните по Select Object (панель Edit), чтобы изменить размер проекта 
перетаскиванием мышью. 

 
Вы можете изменить высоту и ширину проекта или пропорционально изменять размеры проекта, 
используя маркеры – манипуляторы выделения.  
 
Как изменять размеры проекта перетаскиванием мышью 
1  Выберите проект для изменения размеров. 
 Вокруг выделенного проекта появятся восемь меток – манипуляторов выделения. 
2  Перетащите мышью манипулятор, чтобы изменить 

размер проекта. 
 
 
◄    Для пропорционального изменения высоты и   

    ширины используйте угловые маркеры 
 
 

 
 

пропорциональное     пропорциональное  
изменение размеров    изменение размеров 

                    относительно центра 
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Original design Rotated CWRotated CCW

 
 

◄ Для изменения высоты используйте верхний средний 
или нижний средний маркеры. 

  
Изменение по вертикали 

 
 

 
 
 

◄ Для изменения ширины используйте средние боковые 
маркеры. 

                                   Изменение по горизонтали 
 
Совет: Для изменения размеров относительно центра во 
время перетаскивания маркера удерживайте нажатой 
клавишу Shift. Нажмите Ctrl+Shift, чтобы изменить высоту  
и ширину одновременно относительно центра.  
 
           

 
 
 

 
Вращение проектов 
 
Вы можете поворачивать проекты непосредственно на 
экране перетаскиванием мышью или назначив угол 
поворота. 
 
 

Вращение объектов инструментом Rotate 
CCW/CW 
 

Щелкните левой кнопкой по значку Rotate CCW/CW (панель Edit), чтобы повернуть 
проект на 45° против часовой стрелке. Щелкните правой кнопкой по значку Rotate 
CCW/CW, чтобы повернуть проект на 45° по часовой стрелке. 

 
Используйте инструмент Rotate CCW/CW (Поворот против часовой стрелке/по часовой стрелке), 
чтобы поворачивать объекты на 45° в любом направлении. 
 
Как вращать объекты инструментом Rotate CCW/CW 
1  Выберите проект для поворота 
2   Выберите проект  инструментом Select Object (Выбор объекта). 
3  Щелкните по значку Rotate CCW/CW на панели инструментов.  

◄ Щелчок правой кнопкой – поворот на 45° по часовой стрелке. 
◄ Щелчок левой кнопкой – поворот на 45° против часовой стрелке. 

Вращение объектов перетаскиванием мышью 
 

 Щелкните по Select Object (панель Edit), чтобы вращать проект перетаскиванием 
мышью. 

 
При выделении проекта на его крайних точках появляются метки – манипуляторы выделения. Если 
вы щелкните по проекту еще раз, то эти метки преобразуются в маркеры вращения. 
 
Как поворачивать проект перетаскиванием мышью 
1  Выберите проект. 

Изменения по вертикали      Изменения по горизонтали 
в обоих направлениях            в обоих направлениях 

Поворот   Оригинал   Поворот  
против часовой      по часовой 
стрелке.         стрелке 
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Skewed using
click and drag

Mirror horizontal
and vertical (X
and Y)

Mirror
vertical (Y)

Original
design

Mirror
horizontal (X)

2  Щелкните по проекту еще раз. 
 На углах проекта появятся маркеры вращения, а в его центре отобразится местоположение 

анкера. 
       маркер наклона 

      
маркер вращения  
      
местоположение анкера 
 
 
 
 
 

первым щелчком   после второго щелчка 
отображаются    появляются маркеры вращения 
маркеры выделения 

 
3  При необходимости перетащите анкер вращения в 

другое положение. 
4  Щелкните по маркеру вращения и перетащите его по 

часовой стрелке или против часовой стрелки. Во 
время поворота появляется контур и 
перекрестие. 

      
Перекос проекта 
 
Вы можете перекосить проект относительно 
горизонтальной линии, щелкнув по маркеру перекоса и 
перетащить его на требуемый угол. 
 

Перекос объекта  
перетаскиванием мышью 

Как перекосить проект 
1  Выберите проект.   
2  Щелкните по проекту еще раз. 
 Вокруг проекта появятся маркеры поворота и перекоса. Маркеры перекоса имеют форму ромба и 

появляются в средних точках верхнего и нижнего края объекта. 
3  Перетащите маркер перекоса влево или вправо. 
 Проект будет перекошен в горизонтальном направлении. Контур и 

перекрестие покажут изменение формы объекта. 
Перетащите маркер перекоса  

влево или вправо. 
 

Перевод проектов в зеркальное отображение 
 

Щелкните по кнопке Mirror Horizontal (панель Edit), чтобы перевернуть объект на 
горизонтальной оси. 
 
Щелкните по кнопке Mirror Vertical (панель Edit), чтобы перевернуть объект на  

                вертикальной оси. 
 
Вы можете зеркально переворачивать объекты на 
горизонтальной или вертикальной оси, используя инструмент 
Mirror. 
 
Как переводить объекты в зеркальное отображение с 
использованием инструментов Mirror Horizontal или Mirror 
Vertical  
1  Выберите проект для зеркального переворачивания. 
 
2  Щелкните по значку Mirror Horizontal, чтобы 

перевернуть объект по горизонтали, или Mirror 
Vertical,  чтобы перевернуть объект по вертикали. 

Перетащите угол,          Перетащите анкера         Перетащите угол, чтобы  
чтобы повернуть           местоположение   повернуть объект вокруг  
объект вокруг анкера.                    анкера. 
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Enter text

 

Глава 7 
 
 

Основные сведения о текстовых 
объектах 
 

Текстовые объекты добавляются к проекту быстро и легко. Вы можете 
поместить текст на прямой горизонтальной линии или по окружности. 
Вы можете применять форматирование текстовых объектов таким же 
образом, как при работе в текстовом редакторе, включая придание 
тексту курсивного или полужирного начертания. Интервалы между 
буквами могут быть определены до или после создания текстовых 
объектов и размещения их в вашем проекте.   
 
В этом разделе описывается, как добавлять текст к проектам вышивки. Также объясняется, как 
использовать базовые линии текста и форматировать текст. 

 
Добавление текста к проектам вышивки  
 

 
Щелкните по инструменту Lettering (панель Edit), чтобы ввести текст в 
диалоговое окно и настройки параметров вышиваемого текста. 
 

 
Операционная система Windows поставляется с коллекцией шрифтов TrueType, другие шрифты 
устанавливаются с различными прикладными программами. Все установленные в вашем компьютере 
шрифты TrueType доступны для размещения в текстовых объектах вашего проекта. Используя 
диалоговое окно Object Properties – Lettering, вы можете назначить формат текста, прежде чем 
добавлять его в проект. Это наиболее традиционный метод, который удобно использовать с более 
сложными проектами. 
 
Примечание: Не все шрифты TrueType пригодны для включения в проекты вышивания. 
Поэкспериментируйте с понравившимся вам шрифтом и различными настройками стежка. 
 
 
Совет: Для установки новых шрифтов откройте Control Panel (Панель управления). Дважды щелкните 
по папке Fonts (Шрифты), затем выберите File (Файл) > Install New Font (Установить новый 
шрифт). Прежде чем вы сможете использовать новый шрифт, вам нужно перезагрузить компьютер, и 
BERNINA ART Design отобразит новый шрифт в списке Alphabet. 
 
Как добвалять текстовые объекты к проектам вышивки 
1 Нажмите кнопку Lettering (Текст). 
 Откроется диалоговое окно Object Properties -  
     Lettering (Свойства объекта - Текст). 
 
       
 
                                   
  
 
 
 
 
 
 

Введите текст  



Глава 7: Основные сведения о текстовых объектах 

BERNINA ART Design – Руководство пользователя 40

Alt key combination

2 В окно ввода текста введите текст, который вы хотите вышить. 
 Чтобы начать новую строку текста, нажмите Shift + Enter. 
 Совет: Вы можете вставить изменение цвета между двумя буквами, поместив символ знака 

вставки (^). Последующие буквы по умолчанию примут следующий цвет из последовательности 
палитры. 

3 Выберите алфавит из списка Alphabet. Появятся все установленные в вашем компьютере шрифты  
     TrueType. 
4   Выберите форматирования настройки базовой линии для текста. Подробнее см. в разделе  
     Форматирование текста. 

Совет: Перед выбором алфавита обратите внимание на размеры букв. Некоторые алфавиты 
выглядят лучше в меньшем размере. Другие могут быть вышиты в большом размере. См. также 
Форматирование текста. 

5 Нажмите кнопку ОК. 
6 Щелкните в том месте, куда вы хотите поместить текст, или наметить 

базисные точки для выбранной вами базовой линии. 
 Подробнее см. в разделе Применение базовых линий текста. 
 Текст будет вышит с использованием выбранного шрифта.  
      Настройки шрифта можно изменить в закладке Fill Stitch в любой момент. 
      Подробнее см. в разделе Изменение типа стежков. 
 
  
Добавление специальных шрифтовых знаков 
 
Используйте Таблицу символов (Character Map) системы Windows для быстрого доступа к 
специальным символам и буквам. Таблица символов обычно входит в стандартный пакет системы 
Windows.  
 
Совет: Вы можете создавать специальные символы из любого алфавита, удерживая нажатой 
клавишу Alt на клавиатуре и набирая 0 (ноль) и код символа на цифровой клавиатуре. Например, 
чтобы выбрать è с кодом 232, наберите Alt + 0232. Символ появится, как только вы отпустите 
клавишу Alt. В таблице символов вы найдете коды для всех символов. 
 
Как пользоваться таблицей символов 
1 Откройте Таблицу символов ОС Windows. 
 Эта таблица находится по адресу: кнопка  Start (Пуск) > 

Programs (Программы) > Accessories (Стандартные) > 
System Tools  (Служебные) > Character Map (Таблица 
символов). 

     
 
 
2 Дважды щелкните по символу или выберите его и 

нажмите кнопку Select (Выбрать). 
 Символ появится в поле Characters to copy (Копировать 

символы). 
 
Примечание: Эквивалентный код клавиши Alt показывается в нижней части диалогового окна. Этот 
код можно использовать для ввода символа непосредственно на экране. 
 
 3 Нажмите кнопку Copy (Копировать), чтобы скопировать символ в буфер обмена.  
4 Вставьте его в панель ввода текста закладки Lettering. 
 Чтобы сделать это, нажмите Ctrl + V. 
5  Нажмите кнопку Apply. 
 Продолжайте создавать текстовый объект обычным способом. 
  

Код клавиши Alt
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Select baseline

Применение базовых линий текста 
 
Базовые линии определяют форму текстовых объектов в проекте. 
Вы можете поместить текст на прямой горизонтальной или 
вертикальной линии, по окружности или по дуге или же создать 
собственную базовую линию произвольной формы. В зависимости 
от используемой базовой линии потребуются различные базовые точки.  
Вы можете оцифровывать базовые линии на экране. 
 

В базовых линиях используются стандартные установки, определяющие их размеры, межбуквенные 
интервалы и углы наклона. BERNINA предоставляет возможность как диалогового, так и точного 
цифрового управления многими настройками базовых линий. Имеется возможность изменять тип 
базовой линии, ее длину, радиус и угол, а также ее положение. 
 

Примечание: BERNINA ART Design  запоминает, какую базовую линию вы использовали в последний 
раз и будет использовать ее, если вводите текст непосредственно на экране. 

Выбор базовых линий 
 
Используйте значок Lettering (панель Edit) для выбора базовых линий и настройте 
установки базовой линии. 

Используйте значок Free Line для создания горизонтальных базовых линий 
произвольной или заранее определенной длины. 

Используйте значок Circle CW для создания базовых линий по верхней дуге по 
часовой стрелке. 
 
Используйте значок Circle CCW для создания базовых линий по нижней дуге против 
часовой стрелки. 

 
Имеются различные базовые линии для использования с новыми или выделенными текстовыми 
объектами. Настраивайте базовые линии в диалоговом режиме или через свойства. 
 

Как выбирать базовые линии 
 

1 Выделитетекстовый объект и щелкните по значку Lettering или дважды щелкните по значку 
Lettering. Подрбнее см. в разделе Добавление текста к проектам вышивки. 

 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
 

 
 

2 Выберите базовую линию. 
 Выбор базовой линии зависит от желаемого вами эффекта. Вы можете оцифровывать различные 

базовые точки в зависимости от выбранной вами базовой линии. Имеются следующие опции: 
◄ Прямая горизонтальная линия. Подробнее см. в разделе Создание горизонтальных 

базовых линий. 
◄ Окружность по часовой стрелке. Подробнее см. в разделе Создание базовых линий по 

окружности. 
◄ Окружность против часовой стрелки. Подробнее см. в разделе Создание базовых линий по 

окружности. 
3 Нажмите кнопку Apply. 
Выбранная базовая линия применима к любому выделенному текстовому объекту или вновь 
созданным текстовым объектам. 
Совет: Создавайте идентичные базовые линии путем дублирования или копирования в вашем 
проекте. 

Создание горизонтальных базовых линий 
 

Используйте значок Lettering (панель Edit) для выбора базовых линий и настройте 
установки базовой линии. 
 
Используйте значок Free Line (диалоговое окно Object Properties – Lettering) для 
создания горизонтальных базовых линий произвольной или заранее определенной 
длины. 

Выбор базовой линии 



Глава 7: Основные сведения о текстовых объектах 

BERNINA ART Design – Руководство пользователя 42

 
Прямые горизонтальные базовые линии не имеют фиксированной заранее 
определенной длины. Они растягиваются по мере добавления букв. 
      
Как создавать горизонтальные базовые линии 
1 Выделите текстовый объект и щелкните по значку Lettering или дважды щелкните по значку 

Lettering. Подрбнее см. в разделе Добавление текста к проектам вышивки. 
2 Введите текст в окно ввода текста.  
3 Выберите значок Free Line (Свободная линия). 
4 Нажмите кнопку Apply. 
5 Щелкните по экрану по тому месту, в которое вы хотите вставить буквы. 

Создание базовых линий по окружности 
 

Используйте значок Lettering (панель Edit) для выбора базовых линий и настройте 
установки базовой линии. 
 
Используйте значок Circle CW (диалоговое окно Object Properties – Lettering)  
для создания базовых линий по часовой стрелке. 
 

  Используйте значок Circle CCW (диалоговое окно Object Properties – Lettering)  
  для создания базовых линий против часовой стрелки. 

 
Используйте базовые линии по окружности по часовой стрелке и  
против часовой стрелки, чтобы расположить буквы по полной 
окружности. Вы можете расположить текст на окружности по 
часовой стрелке (CW) или против часовой стрелки (CCW). По умолчанию 
буквы располагаются над  базовой окружностью по часовой стрелке и под 
базовой окружностью против часовой стрелки. По умолчанию они выравниваются по центру.  
       
Как создавать базовые линии по окружности 
1 Выделите текстовый объект и щелкните по значку Lettering или дважды щелкните по значку 

Lettering. Подрбнее см. в разделе Добавление текста к проектам вышивки. 
2 Введите текст в окно ввода текста.  
3 Выберите значок Circle CW  (Базовая линия по окружности по часовой стрелке)  или Circle CCW 

(Базовая линия по окружности против часовой стрелки) и нажмите кнопку Apply. 
 В строке состояния будут появляться подсказки. 

4 Щелкните по экрану в то место, в которое вы хотите вставить центр окружности.. 
 
     
 
 
 
 
 
 
 
 
5  Наметьте точку на контуре окружности, чтобы определить 

радиус. 
6  Нажмите Enter для завершения установки окружности. 
7  Альтернативно, если вы хотите создать овальную 

базовую линию, наметьте третью контрольную точку. 
 
                                
 

Щелкните, чтобы 
наметить центр 
окружности Щелкните, 

чтобы 
установить 
радиус

Нажмите Enter 
для завершения

Щелкните, 
чтобы  
определить  
радиус овала 

Нажмите Enter, чтобы  
завершить установку окружности 



Глава 7: Основные сведения о текстовых объектах 

BERNINA ART Design – Руководство пользователя 43

8  Нажмите Enter для завершения создания овала.  
 
Совет: Наметьте  достаточно большую окружность для размещения вашего текста.  
Если она слишком мала или текст слишком длинен, текст будет искажен. Но вы можете изменить 
радиус базовой линии в диалоговом окне Object Properties.  
 
 

Baseline Radius:
20�mm

Baseline Radius:
40�mm

Adjust baseline radius

 
Форматирование текста 
 
Вы можете преобразовывать внешний вид текста, изменяя настройки формата в диалоговом окне 
Object Properties – Lettering. Изменяйте текущие настройки формата до или после добавления текста 
таким же образом, как и для других объектов. 

Придание буквам курсивного начертания 
 

Щелкните по значку Lettering (панель Edit) для настройки наклона букв. 
 

Вы можете наклонять буквы влево или вправо для создания эффекта курсивного шрифта. По 
умолчанию наклон равен 0°, что соответствует прямому шрифту. Максимальный наклон букв 45°. 
 
Как придать буквам курсивное начертание 
1 Выделите текстовый объект и щелкните по значку Lettering или дважды щелкните по значку 

Lettering. Подрбнее см. в разделе Добавление текста к проектам вышивки. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 

 
2 Введите угол в поле Italic (Курсив). 
 Вы можете ввести любой угол наклона в пределах от 45° до -45°. 
3 Нажмите кнопку Apply. Выбранная настройка применима к любому выделенному текстовому  
     объекту или вновь созданным текстовым объектам. 

      
угол наклона 0°                                                                                угол наклона -45° 

      
угол наклона 45° 

 

Придание буквам полужирного начертания 
 
Щелкните по значку Lettering (панель Edit) для настройки полужирного начертания. 
 

Вы можете создать эффект полужирного начертания букв путем увеличения установок компенсации 
стягивания для выбранных текстовых объектов.  
 

Настройка радиуса  
базовой линии 

Радиус базовой 
линии 40 мм 

Радиус базовой 
линии 20 мм 

Выбор угла 
наклона букв 
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Как придать буквам полужирное начертание 
1 Выделите текстовый объект и щелкните по значку Lettering или дважды щелкните по значку 

Lettering. Подрбнее см. в разделе Добавление текста к проектам вышивки. 
     Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
2 Нажмите кнопку Effects.  Откроется диалоговое окно Effects (Эффекты). 

 
Увеличьте компенсацию стягивания 

3 Выберите закладку Others (Другие). 
4  Проставьте флажок в окошке Pull Compensation (Компенсация ткани) и увеличьте значение 

компенсации стягивания  до 0.4 - 0.6 мм. 
 Величина компенсации стягивания не должна превышать 0,6 мм, иначе буквы могут быть 

искажены. 
5   Нажмите кнопку Apply. 

Выбранная настройка применима к любому выделенному текстовому объекту или вновь созданным 
текстовым объектам. 

                      
       Компенсация стягивания 0,2 мм  Компенсация стягивания 0,6 мм 

 

Подгонка интервалов между буквами по всему тексту  
 
Щелкните по значку Lettering (панель Edit), чтобы изменить интервал между 
буквами. 

 
 
Интервал между буквами можно изменить в любой момент. 
 
 
Как подогнать интервалы между буквами  
1 Выделите текстовый объект и щелкните по значку Lettering или дважды щелкните по значку 

Lettering. Подрбнее см. в разделе Добавление текста к проектам вышивки. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
 
2 Введите значение интервала в мм. 

 

Adjust letter spacing
Установите значение интервала 

 
3 Нажмите кнопку Apply.  

Выбранная настройка применима к любому выделенному текстовому объекту или вновь  
созданным текстовым объектам. 

 

 
 
Интервал: 1 мм   Интервал: 3 мм 
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ChildsEdit text

Adjust settings

 

Глава 8 

 

 

Правка вышиваемых текстов 
 

BERNINA ART Desing предоставляет возможность как 
диалогового, так и точного цифрового управления многими 
атрибутами, воздействующими на текстовые объекты. Текст 
можно изменять через диалоговое окно. Цвета текста можно 
изменять с помощью функции Color Palette. 
 
Размер можно изменять в диалоговом режиме или вводом 
соответствующих цифр. Для мелких, узких букв 
стабилизирующие стежки могут не потребоваться, в 
зависимости от размеров букв и вида материала, на 
которых они будут вышиты.  
После изменения размера текста Вам может потребоваться 
добавлять или удалять стабилизирующие стежки и устанавливать вышивальные стежки. После 
этого Вы сможете сохранить индивидуальные настройки к существующему шаблону проекта 
для будущего применения. 
 
В этой главе описывается, как редактировать текстовые объекты. Кроме того, рассматриваются 
способы изменения цвета и размера текста, а также трансформирования текстовых объектов. 
Поясняется так же, как удалять стабилизирующие стежки из небольших букв и устанавливать 
вышивальные стежки. Рассматривается управление шаблонами  текстовых объектов.  

 
Редактирование текстовых объектов 

 
Используйте инструмент Lettering (панель Edit) для редактирования текста. 
 

Если вы создали текстовый объект, вы можете изменять его диалоговое окно Object Properties – 
Lettering. Если Вы импортировали вышивальный проект с текстом, который Вы хотите редактировать, 
то оригинальный шрифт, использованный в данном проекте, не распознается. Чтобы редактировать 
его, необходимо выбрать другой шрифт типа TrueType или другой шрифт, который инсталлирован в 
Вашем ПК. 
 
 
Как редактировать текстовый объект  
1 Выберите текстовый объект и щелкните на кнопку Lettering. 

 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
 
 
 

 
 
 
 

 
 
 
 

 Правка 
текста

Настройка 
параметров:
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2 Отредактируйте текст в окне ввода текста. 
3 При необходимости выполните любые другие изменения. 
 Подробнее см. в разделе   Форматирование текста. 
    
Совет: Если Вы импортировали вышивальный проект с текстом, поле «Alphabet» останется пустым, 
потому что текст не распознается как TrueType-шрифт. Поэтому необходимо выбрать другой шрифт 
типа TrueType или другой шрифт, который исталлирован в Вашем ПК. 
 
4 Нажмите кнопку Apply.  

 
        
 
 
 

Примечание: Буквы заполняются стежками в соответствии с текущими установками на закладке Fill 
Stitch (Заполняющий стежок) диалогового окна Object Properties – Lettering. Вы можете изменить их в 
любое время. Подробнее см. в разделе  Изменение типа стежков. 
 
 
Изменение цвета букв 
 
Новые текстовые объекты создаются с использованием выбранного цвета в цветовой панели. Вы 
можете изменить цвет перед каждым созданием. Если нужного вам цвета нет в цветовой палитре, 
вам может потребоваться добавить его.  
 

C

 
 
Примечание: Вследствие различий в характеристиках мониторов и видеокарт компьютера цвета, 
отображаемые на экране, следует считать приблизительными. Нитки должны быть всегда подобраны 
соответствующей физической цветовой карте. 
 

Выбор нового текущего цвета 
 

 Используйте Color (Цвет) (панель Stitch and color) для выбора текущего цвета. 
 

При создании  нового текстового объекта он автоматически принимает цвет, выбранный в цветовой 
палитре. Это "текущий" цвет. 
 
Как выбрать новый текущий цвет 
1  Отмените выделение всех объектов. Текущий выбранный (по умолчанию) цвет показывается на 
    панели с направленной вниз стрелкой. 
2  Щелкните по стрелке около значка Color на панели Stitch & Color. 
    Откроется цветовая палитра.  

 
3   Выберите цвет из цветовой палитры. Этот цвет становится текущим для всех новых объектов. 
 

Изменение цвета букв 
 

 Используйте Color (Цвет) (панель Stitch and color) 
для изменения цвета буквы.  

 
Вы можете изменять цвет отдельных букв в пределах текстового 
объекта в вашем проекте в любое время.  

Текущий цвет 
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Как изменять выбранного объекта 
1  Выберите текстовый объект, цвет которого Вы хотите изменять.  
 
2  Щелкните по стрелке около значка Color на панели Stitch & Color. 

 Откроется цветовая палитра.  
 

3  Выберите цвет из цветовой палитры. Цвет выбранного объекта меняется  
немедленно.  

 
 
Изменение размеров текста 
Вначале при создании текста он может быть слишком большим или слишком малым. Размер 
текстового объекта может быть изменен одним из следующих способов: 
◄ изменением размеров на экране инструментом Select Object (Выбор объекта). 
◄ подгонкой ширины и высоты объекта на закладке Lettering 
◄ подгонкой ширины и высоты объекта на закладке General 
 

Изменение размеров текста инструментом Select Object 
 Используйте инструмент Select Object (панель Edit) для изменения размеров  
 текстового объекта на экране.  

 
Вы можете изменять размер текстового объекта по вертикали, по горизонтали или пропорционально, 
используя инструмент Select Object (Выбор объекта). См. также раздел Преобразование текста 
инструментом Select Object. 
 
Как изменять размеры текста инструментом Select Object 
1  Щелкните по значку Select Object и выберите текстовый объект.  
     Изменение размера по вертикали 

 
2  Перетащите мышью одну из квадратных контрольных точек, чтобы изменить объект по    
горизонтали, по вертикали или пропорционально. 

    При перетаскивании теневым контуром будет показан новый размер текстового объекта. 
 

Drag

 
3  Для завершения отпустите кнопку мыши. 
 

Подгонка текста по высоте и ширине 
 Используйте инструмент Lettering (панель Edit) для подгонки текста по высоте и 
ширине. 

 
Вы можете изменять ваши текстовые объекты по вертикали, по горизонтали или пропорционально с 
помощью закладки Lettering (Текст) диалогового окна Object Properties – Lettering. 
 
Совет: Изменяйте внешний вид букв путем изменения их ширины по отношению к высоте. 
Оригинальное соотношение равно 100 %. 

Пропорциональное изменение 
размера 
 
Изменение размера по горизонтали 

Перетащить
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Выберите параметры для 
высоты и ширины A

 
Как подгонять текст по высоте и ширине 
1  Выберите текстовый объект и щелкните по значку Lettering или дважды щелкните по выбранному  
    текстовому объекту. 
    Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
 

Adjust width percentage

Enter height

 
2  В поле Height (Высота) введите высоту текстового объекта в миллиметрах. 
    Высоту букв следует выбирать в пределах от 1 до 200 мм.  
3  Введите ширину текстового объекта в поле Width (Ширина) в виде процентного отношения к  
    высоте. 
4  Нажмите кнопку Apply. 
 
Совет:  Альтернативно выберите закладку General. Введите параметры для высоты и ширины либо в 
мм или в %.  

 
 . 
\ 
 

Выбранная настройка применима к любым выделенным текстовым объектам. 
                Оригинал     высота 140 % 

Original Height 140%

Width 140%

 
ширина 140 % 

 
Преобразование текста инструментом Select Object 
 

Используйте инструмент Select Object (панель Design) для преобразования 
текстового объекта на экране. 

 
Вы можете поворачивать и наклонять текстовые объекты путем манипулирования контрольными 
точками на экране с использованием инструмента Select Object (Выбор объекта).  
 
Как преобразовывать текст инструментом Select Object 
1  Щелкните по значку Select Object и выберите текстовый объект. 
    Появятся метки - маркеры выделения, позволяющие изменять размеры объекта. Подробнее см. в 
    разделе Изменение размеров текста инструментом Select Object. 
2  Щелкните по текстовому объекту еще раз. 
    Появится другой комплект маркеров выделения. Эти точки позволяют поворачивать и наклонять 
    текстовый объект. 
              Маркер наклона 
                 

 
 
 
Маркер вращения  
 
 

Точка вращения  
 
3  Перетащите один из ромбовидных маркеров, чтобы придать 
текстовому объекту наклон. 
 
       

Выбор высоты букв  
 
Выбор ширины в процентах 

Перетащить 
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4 Перетащите один из маркеров в виде светлого квадрата, чтобы повернуть текстовый объект.  
 

Перетащить 
 
 
 

Точка центра вращения  
 
Совет: Перетащите точку центра вращения в новое положение перед вращением объекта. 

       
новая точка центра вращения  

 
5 Для завершения отпустите кнопку мыши. 
 
Отключение функции автоматической стабилизации ткани для мелких букв 
 

 Используйте инструмент Lettering (панель Edit) для отключения функции 
автоматической стабилизации для мелких букв. 

 
Качество большинства букв может быть улучшено при использовании стабилизирующих стежков 
таким же образом, как и для других вышиваемых объектов. Для мелких, узких букв стабилизирующие 
стежки могут не потребоваться, в зависимости от размеров букв и вида материала, на которых они 
будут вышиты. См. также  
 
Как отключить функцию автоматической стабилизации ткани для мелких букв 
1 Выберите текстовый объект и и щелкните по значку Lettering или дважды щелкните по  
     выбранному текстовому объекту. 
     Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
 
2 Нажмите кнопку Effects. Откроется диалоговое окно Effects.. 
 

 
2 Выберите закладку Uderlay. 
3 Уберите флажок из окошка Underlay. Функция стабилизации ткани будет отключена. 
 

 
 
Применение различных типов стежков в текстовых 
объектах 
 
По умолчанию текстовые объекты заполняются стежками гладьевого 
валика, но  Вы можете также применять заполняющие стежки. 
 

Уберите флажок 
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Изменение типа стежков 
 

Используйте Satin (панель Stitch and Color) для узких колонок и форм. 
Используйте Step (панель Stitch and Color) для заполнения крупных форм с  

                             нерегулярными контурами. 
 
Вы можете изменять тип стежков в любое время.  
 

Как изменять тип стежков в стежковых объектах 
 

1 Выберите текстовый объект. 
2 Выберите тип заполнящих стежков  - Satin или Step из  открывшегося списка. Выбранный 
     тип стежка будет применен к выбранному объекту или объектам. Будут использованы текущие  
     настройки. 

Настройка стежка гладьевого валика для текстового объекта 
 

 Используйте инструмент Lettering (панель Edit) для настройки разных типов 
стежков для текстового объекта.  

 
По умолчанию текстовые объекты заполняются стежками гладьевого валика. При малой ширине 
буквы стежки располагаются плотно, поэтому требуется меньше стежков для покрытия ткани. Если 
колонка очень узкая, стежки должны быть менее плотными, поскольку слишком большое количество 
проколов иглой может повредить материал. 
Вы можете заполнять формы текста специальным гладьевым стежком (Special Satin), как и обычным 
стежком гладьевого валика. Этот стежок особенно подходит для заполнения крупных нерегулярных 
текстовых форм, которые слишком велики для гладьевого валика.  
 
Как настроить стежок гладьевого валика для текстового объекта 
1 Выберите текстовый объект и и щелкните по значку Lettering или дважды щелкните по  
     выбранному текстовому объекту. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
 
 
 
 
 
 
 
 
 
 
 
2 Выберите закладку Fill Stitch (Заполняющий стежок). 
3 Выберите режим установки шага стежка, который вы хотите применить к своему тексту. 
4 Если вы выбрали Manual настройте интервал сами. 
5 Выберите тип стежка гладьевого валика.  
6 Нажмите кнопку Apply. 

Автоматическая установка  
шага стежков 

 
Установка шага стежков  

вручную. 

Настройка простегивающего стежка для текстового объекта 
 

 Используйте инструмент Lettering (панель Edit) для настройки разных типов 
стежков для текстового объекта.  

 
Вы можете заполнять формы текстового объекта простегивающим 
стежком. Этот стежок особенно подходит для заполнения крупных 
объектов нерегулярной формы. 

Выберите закладку Fill Stitch

Выберите режим установки
шага стежков

Выберите тип стежка Satin
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Как настроить простегивающий стежок для текстового объекта 
1 Выберите текстовый объект и и щелкните по значку Lettering или дважды щелкните по   

выбранному текстовому объекту. 
    Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 

Adjust stitch
spacing and length

Select Fill Stitch
tab

Select Step

 
2 Выберите закладку Fill Stitch (Заполняющий стежок) и  Step (Простегивающий стежок) из списка 

Stitch Type (Тип стежка). 
 

3 Подгоните шаг стежков, чтобы увеличить или уменьшить их 
плотность и отрегулируйте длину стежка. 

6  Нажмите кнопку Apply.  
 
 
Управление шаблонами текстовых объектов 
 
Шаблоны – это специальные файлы, используемые для сохранения стилей и стандартных, 
применяемых по умолчанию настроек. Используйте шаблоны, когда вы создаете наиболее часто 
применяемые типы проектов, чтобы не устанавливать текущие свойства каждый раз заново. 
Например, шаблон может содержать стандартные объекты и образец текста. Он может просто 
содержать предпочитаемые настройки стежков, шрифт текста и его размер, в также набор цветов в 
качестве текущих свойств. Или в нем может быть задана специальная плотность стежков, 
компенсация стягивания или набор стабилизирующих стежков, подходящих для различных тканей. 

 
Шаблон NORMAL является стандартным шаблоном, поставляемым с ПО BERNINA 
ART Design. Он содержит текущие свойства объекта. Если необходимо, вы 
можете вернуться к оригинальному шаблону NORMAL после его модификации. 
Подробнее см. в разделе Возвращение к шаблону NORMAL. 

Сохранение  текущих свойств текстового объекта в шаблоне 
 

 Используйте инструмент Lettering (панель Edit) для сохранения актуальных 
настроек текстового объекта в шаблоне.   

 
Сохранение настройки текстового объекта в шаблоне происходит в диалоговом окне Object Properties  
- Lettering (Свойства объекта - Текст). 
 
Как сохранить текущие свойства текстового объекта в шаблоне 
 
1  Откройте диалоговое окно Object Properties  - Lettering 
(Свойства объекта - Текст). 
 
◄ Для использования текущих свойства текстового 

объекта отмените выделение всех объектов и затем 
нажмите по значку Lettering.  

◄ Для использования свойств для конкретного 
текстового объекта выберите текстовый объект и 
щелкните по Lettering или дважды щелкните по нему. 

 
2  Измените настройки свойств текстового объекта, как 

вам требуется. 
3  Щелкните по Save To Template (Сохранить в шаблоне). 

Выберите закладку 
Fill Stitch 

Выберите Step

Настройка шага и 
длины стежков

Щелкните по  
Save To Template 

Измените настройки,  
как вам требуется. 
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Примечание: В шаблоне сохраняются только текущие свойства текстового объекта, но не объекты 
или другие настройки в проекте. 
 
4  Щелкните по OK, чтобы обновить шаблон. 
5  Щелкните по OK, чтобы возвратиться к окну проекта. 
    Новые настройки сохраняются в шаблоне, на основе которого был создан проект, и доступны для 
    использования. 
 

Возвращение к шаблону NORMAL 
Если вы изменили шаблон NORMAL, поставленный с ПО BERNINA ART Design, вы можете 
вернуться к его оригинальной версии. Первоначальная копия всегда сохраняется, так что шаблон 
NORMAL может быть восстановлен. 
 
Как возвратится к шаблону NORMAL 
 
1  Закройте BERNINA ART Design. 
2  Нажмите на панели задач Windows кнопку Пуск (Start) и выберите Программы (All Programs) > 
   BERNINA ART Design > Revert. 
   Откроется диалоговое окно Revert to Factory Template (Возврат к оригинальному шаблону) 
         
 
                 
 
Выбор  
шаблонов 
 
 
 
 
 
 
Примечание: Может потребоваться 1 или 2 минуты для открытия диалогового окна. 
 
3  Выберите опцию Templates (Шаблоны) и щелкните по OK. 
  Оригинальные настройки шаблона NORMAL будут восстановлены. 
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Глава 9 
 
 
 

Установка аппаратных средств и 
настройка системы 
 

Для работы с BERNINA ART Design вам необходимо подсоединить периферийные устройства. 
К ним относятся принтеры, вышивальные машины. 
BERNINA ART Design позволяет настраивать различные установки системы, управляющие 
внешним видом проектов на экране, отображением информации о проекте, поведением окна 
проекта, и другие установки. 

 
В этом разделе описывается, как настраивать вышивальные машины и сканеры и как 
калибровать монитор. Кроме того, объясняется, как изменять интервал сетки и опции 
позиционирования и изменять опции пялец. Имеется также информация о том, как настраивать 
отображение указателя мыши и как установить опцию автосохранения. 
 

Установка аппаратных средств 
 
Различные устройства устанавливаются различными способами – некоторые в ОС Windows через 
Панель управления, другие в самой программе BERNINA ART Design itself. За указаниями по 
подключению устройств к компьютеру и их настройке в системе Windows обратитесь к прилагаемым к 
устройствам инструкциям, а также к документации по Microsoft Windows. 
 

Настройка подсоединения периферийного устройства 
Периферийные устройства, такие как принтеры, подсоединяются к имеющемуся порту на передней 
или задней стороне компьютера. Это может быть последовательный, параллельный или USB порт. 
Конфигурацию программного обеспечения нужно выбирать через Панель управления системы 
Windows. 
 

Настройка последовательного порта 
Последовательные COM-порты компьютера имеют ответные 9- или 25-штырьковые разъемы. Они 
называются COM1, COM2 и т.д.  Количество имеющихся портов ограничивает количество 
подключаемых устройств. Если требуются дополнительные порты, вы можете их добавить. BERNINA 
ART Design дает возможность иметь до 4 последовательных портов. 
 
Примечание: Вы должны уметь идентифицировать порты вашего компьютера. При возникновении 
сомнений проконсультируйтесь со специалистом. 
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Измеренная высота 

Настройка параллельного порта 
Параллельные порты используются для подсоединения принтера и сканера. Они называются LPT1, 
LPT2 и т.д.  
 
Настройка USB-порта 
Порты USB (Universal Serial Bus) используются для подсоединения, например, Вашей вышиальной 
машины. 
 

Настройка вышивальных машин 
Ваша вышивальная машина BERNINA должен быть подключена к порту COM1, COM2, COM3, COM4 
или USB вашего компьютера. Подробно о подключении машины к компьютеру можно узнать в 
Руководстве по эксплуатации вашей вышивальной машины. 

Настройка принтеров 
Ваш принтер подключен к USB- или параллельному порту. Некоторые принтеры могут быть 
подключены к любому типу порта. BERNINA ART Design использует выбираемый по умолчанию 
принтер, назначенный в парке Printer (Принтер) в Панели управления Windows. Руководствуйтесь 
инструкцией по принтеру, чтобы обеспечить правильную настройку. Воспользуйтесь Справкой 
Windows (Пуск > Справка > Указатель, затем выберите Принтер по умолчанию), чтобы получить 
указания по установке принтера по умолчанию. 
 
Калибровка монитора 
 

Используйте команду Display Setup (меню Settings) для калибровки монитора.  
 

Вам потребуется откалибровать монитор, так чтобы проект отображался в масштабе 1:1 в 
натуральную величину. Это необходимо в том случае, когда вы впервые устанавливаете BERNINA 
ART Design или по какой-либо причине меняете монитор.  
 

Как калибровать монитор 
1 Выберите Settings (Настройки) > Scanner Setup (Настройка монитора). 
 Откроется диалоговое окно Screen Calibration (Калибровка экрана). 

Measure width

Measure
height

 
                    Измеренная ширина 
 
2 Измерьте высоту и ширину диалогового окна. 
3 Введите измеренные значения в поля Width (Ширина) и Height (Высота). 
4 Нажмите кнопку ОК. 
 
Настройка опций сетки 

 
Щелкните правой кнопкой мыши по кнопке Show Grid (панель General) для установки 
базисной точки сетки и интервала. 

 
Вы можете включить или выключить показ сетки, 
изменить интервал сетки или установить базисную 
точку.  
Выровняйте сетку со специфичной точкой в проекте 
путем установки базисной точки, например, если вы 
хотите, чтобы линии сетки пересекали центральную 
точку проекта или чтобы горизонтальная линия 
сетки находилась под определенным объектом. 
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Как настраивать опции сетки 
1 Щелкните правой кнопкой мыши по значку Show Grid (Показать сетку). 
 Откроется диалоговое окно Options (Опции) с открытой закладкой Grid (Сетка). 
 
 
Выберите для  
отображения сетки 
 
 
Введите горизонтальный  
и вертикальный интервалы 
 
 
 
2 Проставьте флажок в окошке Show Grid, чтобы отобразить сетку. 
3 Введите значения интервала сетки (Grid Spacing) для горизонтальных и вертикальных линий. 
4 Проставьте флажок в окошко Set Reference Point (Установить базисную точку). 

Например, вы можете установить базисную точку сетки в центре проекта. Это более простая и 
быстрая операция, чем перемещение всего проекта. 

5 Нажмите кнопку ОК. 
Если вы выбрали опцию Set Reference Point, наметьте базисную точку на вашем проекте. Сетка 
будет выровнена, так что горизонтальные и вертикальные линии сетки пересекались в этой точке. 

 
Настройка опций пялец 

 
Щелкните правую кнопкой мыши инструмент Hoop (панель General) для изменения 
настроек пялец. 

 
Имеется определенный диапазон размеров подбора к 
размеру проекта, а также к числу вышивальных 
машин. Рекомендуется выбирать наименьший размер 
пялец, который будет соответствовать размеру 
проекта. Благодаря этому ткань во время вышивания 
будет оставаться плотно натянутой. 
             

Как настраивать опции пялец 
1 Щелкните правой кнопкой мыши по значку Show  
     Hoop (Показать пяльцы). 
     Появится диалоговое окно Options с открытой  
     закладкой Hoop (Пяльцы).  

 
 

      
Совет: Для скрытия пялец уберите флажок из окошка Display Hoops (Показать пяльцы). 
 

2 Выберите пяльцы из списка Hoop. 
 Выберите положение пялец на панели Position. 

Подробнее см. в разделе Настройка центра пялец. 
3 Нажмите кнопку New Hoop (Новые пяльцы) для  
      создания собственных пялец. 

Подробнее см. в разделе Создание собственных 
пялец. 

4 Нажмите кнопку Edit Hoop (Изменить пяльцы) для  
     изменения существующих пялец. 

Подробнее см. в разделе Редактирование 
собственных пялец. 

5 Нажмите кнопку Delete Hoop (Удалить пяльцы) для       
удаления существующих пялец. 

Подробнее см. в разделе Удаление пялец. 
6 Нажмите кнопку ОК. 
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X/Y lengths L: length A: angle

length = 30.1mm

 
Настройка общих опций 
 
BERNINA ART Design позволяет настраивать различные общие установки, управляющие 
автосохранением проектов, определения положения указателя мыши на экране, а также 
отображением единиц измерения. 
 

Установка функции автоматического сохранения 
 

Выберите Options (меню Settings) для установки опций автосохранения и создания 
резервных копий  

 
Сохраняйте свою работу автоматически с регулярными интервалами, используя функцию Auto Save 
(Автосохранение) для защиты от потери при сбое аппаратных или программных средств.  
Резервная копия файла создается каждый раз при сохранении проекта. Проект сохраняется в папке 
BACKUP программы BERNINA ART Design. Копия имеет то же имя, что и оригинальный файл, но с 
расширением BAK. 
 
Внимание: Резервные копии файлов остаются в папке BACKUP до тех пор, пока вы не удалите их. 
Чтобы эта папка не занимала слишком много места на жестком диске, регулярно удаляйте ставшие 
не нужными резервные файлы. 
 
Как установить опцию автосохранения 
1 Выберите закладку Settings > Options > General. 

Enter auto-save
frequency

 
2 Проставьте флажок в окошке Auto Save Design Every (Автосохранение каждого  проекта) 
3 Введите интервал автосохранения в минутах. 
4 Нажмите кнопку ОК. 
 

Интерпретация положения указателя мыши 
Значения X и Y показывают горизонтальное (X: horizontal) 
и вертикальное (Y: vertical) расстояние указателя от 
относительной или абсолютной отметки. Значение L – 
это длина линии, соединяющей указатель с предыдущей 
точкой, а A – это угол наклона этой линии по отношению 
к горизонтали. 
 
 
 
Отрицательное значение величины X означает, что 
вторая точка расположена слева от первой точки, в том время как 

отрицательное значение величины Y 
означает, что вторая точка находится ниже 
первой. Отрицательные значения углов 
означают, что угол больше 180°, например, 
угол -60° равен углу 300°.  
 
      
 
Совет: Вы можете измерять расстояния на 
экране, пользуясь величинами в статусной 
строке. Подробнее см. в разделе 
Измерение расстояний на экране. 
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Настройка опций отображения положения указателя мыши 
 

Выберите команду Options (меню Settings) для установки опций отображения 
положения указателя мыши.  

 
Когда вы перемещаете мышь, положение указателя отображается в статусной строке в нижней части 
экрана. Вы можете факультативно отображать положение указателя относительно последней 
оцифрованной точки или точки стежка или как абсолютное значение от первой точки укола иглой в 
проекте. 
 
Как настраивать опции отображения положения указателя мыши 
1 Выберите закладку Settings > Options > General. 
 

 Select relative or
absolute pointer

position
 

2 Выберите Relative (Относительную) или Absolute (Абсолютную) установку указателя.  
◄ Relative: показывается положение указателя относительно последней оцифрованной точки или 

точки стежка. Полезно во время оцифровывания или редактирования стежков. 
◄ Absolute: показывается положение указателя в абсолютных единицах от первой точки укола 

иглой в проекте. Полезно для проверки соответствия проекта имеющейся площади.  
3 Нажмите кнопку ОК. 
 

Показ /скрытие всплывающей подсказки измерений 
 

Выберите команду Options (меню Settings) для показа/скрытия всплывающей 
подсказки измерений 
 

Во всплывающей подсказке показывается во время измерений  координаты, расстояние и угол линии 
от указателя мыши до точки, соответствующей центру пялец в пустом проекте. Можно показать или 
скрыть эти данные с помощью окошка Show Measure Tooltip. 
 
Как показать /скрыть всплывающую подсказку измерений 
 
1 Выберите закладку Settings > Options > General. 
 

 Toggle on or off

 
 
2   Проставьте флажок в окошко Show Measure Tooltip для показа подсказки измерений или удалите  
     его для скрытия подсказки измерений. 
 

Measure tooltip
not showing

Measure tooltip
showing
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Глава 10 
 
 

 

 

Вывод  и запись  проектов 
 

Вы можете выводить проекты вышивок различными способами 
– распечаткой в виде рабочих документов, в виде выкроек 
аппликаций, цветных слайдов или таблиц ниток. BERNINA ART 
Design позволяет также сохранять проекты как изображения с 
тканью и деталями одежды.  
 
Если вы отправили проекты непосредственно в машину, они 
могут быть 
потеряны после отключения машины. Помимо сохранения на 
жестком диске, на дискете или компакт-диске, вы можете 
также сохранять проекты в различных запоминающих 
устройствах: в памяти вышивальной машины, на 
вышивальных картах и USB-Stick. .  
 
Прибор Magic Box ("Волшебная шкатулка") позволяет конвертировать файлы, сохраненные в 
различных "неродных" форматах и затем передать на карту памяти, отличную от Magic Card. 
 
В этой главе показывается, как распечатывать и вышивать проекты. Также описывается, как  
считывать проекты из машины и записать их в машину или непосредственно на USB-Stick  и как 
работать с Magic-Box. 
 
 

Распечатка проектов 
 
Вы можете создать бумажную копию ваших проектов, используя стандартные или пользовательские 
настройки принтера. Вы можете также просмотреть проекты перед печатью. Настройте опции 
принтера для отображения информации по вашему желанию. Если вы пользуетесь цветным 
принтером, вы можете печатать в режиме Artistic View (Художественный Просмотр). А также печатать 
таблицы ниток в виде справки для приобретения требуемых ниток.  

Предварительный просмотр и распечатка проектов 
 

Используйте инструмент Print Preview (панель General)  
для просмотра проекта перед печатью. 

 
Используйте инструмент Print (панель General) для печати проекта. 
 

Используйте функцию Print Preview для просмотра информации о вышивании. Проверьте 
последовательность вышивания перед вышиванием проекта, так как вам нужно знать 
последовательность цветных фрагментов. Вы можете создать бумажную копию ваших проектов, 
используя стандартные или пользовательские настройки принтера. 
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Предварительный просмотр и распечатка проектов 
 
1 Нажмите кнопку Print Preview (Предварительный 

просмотр).  
Ваш проект откроется в том виде, в котором он 
будет отпечатан. Большие проекты могут 
изображаться на нескольких страницах в случае их 
распечатки в фактическом размере.  

 
2 Используйте команды для  
     предварительного просмотра при необходимости: 
◄ Next Page = Следующая страница 
◄ Previous Page = Предыдущая страница 
◄ Two Pages = Две страницы - для просмотра 

нескольких страниц. 
◄ Portrait/Landscape = Переключение между портретной и альбомной ориентацией страницы. 
◄ Zoom In/OUT = Щелкните по значку Zoom In/Out, чтобы проверить детали проекта или прочитать 

рабочую информацию. 
 
3 Нажмите кнопку Options, чтобы выбрать опцию печати. 
 Подробнее см. в разделе Настройка опций печати. 
4 Нажмите кнопку Print Now для печати. 

Откроется диалоговое окно Print операционной системы MS Windows®, позволяющее выбрать 
принтер и желаемые настройки печати.  См. также Настройка опций печати вышивальных 
файлов. 

5  Нажмите Close, чтобы вернуться к окну Design  
 
 
Настройка опций печати для вышивания 
 
Настройки печати позволяют детально выбрать вид распечатанного проекта. Вы можете распечатать 
копию вашего проекта с информацией относительно размеров проекта, последовательности 
вышивания цветных фрагментов, количества стежков вместе с изображением проекта. 
Предусмотрены опции, позволяющие включить или исключить из распечатки в режиме просмотра 
Artistic View крестики, отмечающие начальную и конечную точки, соединительные точки, цвет/ткань 
фона и текущие пяльцы. Информация о проекте включает данные об авторе, расчетную длину 
верхней нитки для каждого цвета и общую длину нижней нитки. 
 
 
Как настраивать опции печати для вышивания 
1 Откройте диалоговое окно Print (Печать).   
 Откроется диалоговое окно Print. 
 

 
2 Выберите принтер из списка Name. 
3 Укажите количество копий, которые необходимо распечатать и остальную информацию о печати. 
4 Выберите Options (Опции), если нужно изменить размер изображения, тип просмотра или 

включаемые в распечатку детали. 



Глава 10: Вывод и запись проектов 

BERNINA ART Design – Руководство пользователя 60

 Откроется диалоговое окно Print Options (Опции печати). 
 

     

Select embroidery
elements to print

Print whole design
only

 
5  Выберите опцию Embroidery на панели Elements, 

если она еще не активирована. 
 Все вышивальные стежки показываются по 

умолчанию в нормальном режиме просмотра 
(Design View). 
 
Примечание: Опция Selected Objects не действует 
ПО ART Design.  

 
6  Выберите Artistic View, чтобы распечатать проект в режиме Художественного 

Просмотра. 
7 Включите другие опции, если необходимо: 
 
 
◄ Hoop (Пяльцы): В распечатку включаются пяльцы.  
 
 
 
 
◄ Connectors: Все соединительные стежки проекта 

отображаются, даже если текущая опция Selection 
(Выбор) установлена на Selected Objects 
(Выбранные объекты). 

 

 
 
Совет: Соединительные стежки могут быть использованы как направляющие, когда вы сохраняете 
проект формата ART в нескольких файлах для их вывода при позиционировании проектов, не 
помещающихся в одних пяльцах. 
 
Примечание: В режиме просмотра Artistic View опция Connectors (Соединительные стежки) не 
действует, т.е. вы не сможете увидеть их в этом режиме. 
 
◄ Start/End Crosshair (Крестики в начале/конце): В распечатку включаются начальная и конечная 

позиции иглы. 

Печать всего 
проекта или 
выбранных 
объектов

Выбор 
элементов 

вышивки для 
печати
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Actual size

Fit to Page

 
◄ Background Color/Fabric (Фон Цвет/Ткань): Фон 

страницы заполняется цветом в соответствии с 
настройкой фона (Background). Подробнее см. в 
разделе Изменение фона. 

 
 
8  Выберите опцию размера на панели Size: 
 
◄ Actual Size: проект будет распечатан в том же размере, 

в котором он будет вышит. 

 
◄ Fit to Page: крупный проект будет уменьшен до размера 

печатной страницы, а небольшой проект – 
соответственно увеличен.  

 
◄ % of Actual: Размеры изображения проекта изменяются 
     в соответствии с этой настройкой. 
 
9  Щелкните по ОК.  
 
Распечатка выкроек аппликации 
 
Распечатайте копию узора аппликация для использования в 
качестве шаблона для вырезания мотива 
аппликации из материала. Каждый узор аппликации 
нумеруется в соответствии с последовательностью 
вышивания. 
 
Как распечатать узор аппликации 
1  Выберите File > Print Preview. 
2  Щелкните по значку Options. 
Откроется диалоговое окно Print Options. 
 
3  Выберите опцию Applique Pattern. 
 
 
 
 
4  Щелкните по ОК. 
Каждый узор аппликации нумеруется в 
соответствии с последовательностью 
вышивания. 
 

 

Выбрать для 
распечатки 
элементов 
аппликации 
 

Страница 
скомпонованной 
аппликации 
 
 
 
 
 
 
Страница 
элементов 
аппликации 
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t

#: 3.
Color: Black
Code: 0020
Brand: Isacord 40
Stitches: 1214
Thread Used: 4.57m

 
Примечание: Если выбрана опция Actual Size (Фактический размер), то как скомпонованная 
аппликация, так и индивидуальные выкройки создаются на отдельных страницах. Если 
выбрана опция Fit to Page или % of Actual, то скомпонованная аппликация создается в 
выбранном размере, но индивидуальные выкройки печатаются в фактическом размере на отдельных 
страницах. 
 
5  Щелкните по кнопке Print. 
 

Распечатка таблицы Color Film 
Опция Color Film позволяет вам включить список  цветных слоев текущего проекта вместе с 
информацией о цвете и стежках для каждого слоя. 
 
Как распечатать таблицу Color Film 
1  Выберите File > Print Preview. 
2  Щелкните по значку Options. 
   Откроется диалоговое окно Print Options (Опции печати). 
3  Выберите опцию Color Film. 
 
 
 
 
 
 
 
 
4  Щелкните по ОК. 
Будет включена следующая информация:  

◄ #: номер в последовательности 
 вышивания 

◄ Color (Цвет): Название цвета в 
 соответствии с таблицей ниток. 

◄ Код нитки для заказа. 
◄ Brand: Марка нитки, например Isacord 

 40. 
◄ Stitches: Общее количество стежков для 

 индивидуального цветного слоя. 
◄ Thread Used: Общая длина стежков в 

  индивидуальном цветном слое в 
  соответствующих принятых в системе 
  единицах измерения, например в 
  метрах. 

 
Примечание: Отображаемая здесь информация является той же информацией, которая 
отображена в диалоговом окне Thread Colors (Цвета ниток). Подробнее см. в разделе 
Назначение цвета ниток. 
 

 
5  Щелкните по кнопке Print. 
 
 

Выберите для 
распечатки 
таблицы 
Color Film 

Характеристики 
цветных ниток 
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Распечатка таблиц ниток 
 
Для распечатки таблицы ниток выберите Thread Colors (меню Settings). 

 
Опция Thread Chart > Print (Таблица ниток > Печать) позволяет распечатать список ниток в таблице 
ниток как справка для приобретения ниток. 
 
Как распечатать таблицу ниток 
1  Выберите Settings (Настройки) > Thread Colors (Цвета ниток). 
   Откроется диалоговое окно Design Properties (Свойства проекта > Thread Colors (Цвета ниток). 
 

Щелкните для печати таблицы 

 
2  Выберите таблицу из списка Thread Chart (Таблица ниток). 
3  Щелкните по кнопке Print (Печать). 
  Откроется страница Print Preview (Предварительный  
  просмотр),   отображающая распечатываемую форму  
  выбранной таблицы ниток в   текущей рассортированной  
  последовательности. 
 
Распечатываемая таблица ниток включает название таблицы 
ниток, коды, марки и описание ниток. 
 
4  Используйте при необходимости кнопки Preview (Просмостр): 
 
◄ Next Page: Просмотр следующей страницы. 
◄ Prev Page: Просмотр предыдущей страницы. 
◄ Two Page: Отображение в окне просмотра двух страниц. 
◄ Portrait/Landscape: Переключение между портретной и альбомной ориентацией страницы. 
◄ Zoom In/Out: Увеличить/Уменьшить изображение – используется для просмотра отдельных частей 
    таблицы ниток. 
5  Щелкните по кнопке Print Now, чтобы приступить к процессу печати. 
Откроется диалоговое окно Print операционной системы MS Windows®, позволяющее выбрать  
принтер и выбрать желаемые настройки печати. 

6  Используйте черные прямоугольники в распечатываемом документе, чтобы отметить нитки,  
   которые требуется купить. 
   В таблице имеется также графа Memo для примечаний. 
7  Щелкните по кнопке Print. 
 
 
Вышивание проектов 
 

Используйте инструмент Write to Machine (панель 
General), чтобы передать проект в машину. 

 
Используйте функцию Write to Machine (Передать в машину) 
для непосредственной передачи проекта в готовую для 
работы вышивальную машину BERNINA. См. также 
Передача проектов в машину. 

Выбор 
таблицы 
ниток для 
печати 
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Click to stitch out selected design

 
Совет: Проверьте последовательность вышивания перед вышиванием проекта, так как вам нужно 
знать последовательность цветных фрагментов. Используйте функцию Print Preview для просмотра 
информации о вышивании. Подробнее см. раздел Предварительный просмотр и распечатка 
проектов. 
 
Как вышивать проект 
1  Откройте проект и выберите Design View. Подробнее см. в 
разделе Открытие проектов. 
 
2  Проверьте, подходит ли проект к пяльцам. Используйте 
наименьшие пяльцы из возможных. Подробнее см. в разделе 
Изменение пялец. 
3  Щелкните по значку Write to Machine (Передать в машину). 
Если вы загружаете проект в первый раз после 
включения машины или модуля считывания карт, 
то появится диалоговое окно Bernina Device 
Selection (Выбор устройства Bernina). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4  Если появится запрос, выберите вышивальную 
машину и COM-порт. 
5  Щелкните по ОК. 
Если подсоединение выполнено правильно, 
откроется диалоговое окно Write to 
Embroidery System (Передать в 
вышивальную систему). На экране появится 
имя и пиктограмма вашего проекта. 

 
 
Щелкните, чтобы вышить выбранный проект 

6  Нажмите кнопку Stitch out Selected 
Design (Вышивание выбранного проекта). 
Появится окно Writing file(s) to device (Передача файла(ов) в устройство), за которым последует 
сообщение о подтверждении. Проект будет передан в вышивальную машину, готовый в 
вышиванию. 
Примечание: Если вы отправили проекты непосредственно в машину, они могут быть 
потеряны после отключения машины. Помимо сохранения на жестком диске, на дискете или компакт-
диске, вы можете также сохранять проекты в различных запоминающих устройствах. Сохраненные 
проекты могут быть извлечены для редактирования. См. также раздел Запись проектов в машину. 
 
Считывание проектов из машины 
Вы можете загружать проекты в вышивальное программное обеспечение BERNINA ART Design из 
различных источников как в компьютер, так и в вышивальную машину. После открытия проекты могут 
быть проверены или выправлены перед сохранением на жестком диске или передачей в машину для 
вышивания или сохранения. 
При считывании проектов из машины имеются следующие  возможности: 

Выберите тип 
вышивальной 
машины 
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Выберите тип устройства

◄ Embroidery machine (Вышивальная машина): Большинство машин 
позволяет сохранять проекты с возможностью последующего извлечения 
из памяти машины. Такое устройство подобно встроенной карте памяти. 

◄ Устройство USB Memory Stick: Проекты можно также загружать с 
устройства USB memory stick, вставленного в машину. См. также Запись 
проектов в машину. 

 
Примечание: Устройство USB memory stick может быть вставлено 
непосредственно в ваш компьютер для загрузки в вышивальное 
программное обеспечение BERNINA. 
Подробнее см. в разделе Открытие проектов. 
 
Как считывать проекты из машины 
1  Откройте новый, пустой файл. 
2  Если вы намерены считать проекты с карты или USB stick, вставьте запоминающее устройство в 
машину (или модуль считывания и записи карт памяти). 
Примечание: Подробнее о подсоединении см. в инструкции, прилагаемой к устройству считывания и 
записи вышивальных карт памяти. 
3  Выберите File > Card/Machine Read. 
Если вы загружаете проект в первый раз после включения машины или модуля считывания карт, то 
появится диалоговое окно Bernina Device Selection (Выбор устройства Bernina). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4  Выберите вышивальную машину или устройство считывания карт, а также COM-порт, если 
появится запрос. 
5  Щелкните по ОК. 
Если подсоединение выполнено правильно, откроется диалоговое окно Write to Embroidery System 
(Передать в вышивальную систему). 
Отобразится имя и пиктограмма. 
Появится диалоговое окно Read from Embroidery System and Design Manager (Считывание с 
вышивальной системы и диспетчер проектов). 

 

 

Выбор 
запо- 
минающего 
устройства 
 
Выбор 
проекта 
 
Выбор 
жесткого 
диска 
 
Щелкните 
для 
загрузки 
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6  Выберите требуемое запоминающее устройство, щелкнув по соответствующей кнопке – 
вышивальной машины, карте памяти или USB memory stick. Как только вы выберите кнопку, 
отобразятся все папки и проекты, сохраняемые в соответствующем устройстве памяти. 

Create new folders  
                                 Создайту новую папку 
 

Совет: Щелкните правой кнопкой по значку проекта для вызова всплывающего меню, используемого 
для переименования, удаления или просмотра свойств проекта. 
7  Щелкните по закладке папки (если имеется больше одной закладки) и/или по папке, чтобы 
локализовать проект. 
Совет: Используйте значки в правой части панели для создания новых папок или навигации по 
структуре папок. 
8  Выберите проект. 
В панели Selected Design (Выбранный проект) отобразится изображение проекта. 

C
B

C
p

 
9  Используйте кнопки панели, если потребуется: 

◄ открыть проект для редактирования непосредственно в 
вышивальном программном обеспечении BERNINA; 

◄ переименовать проект; 
◄ удалить проект; 
◄ получить доступ к свойствам проекта 

 
 
10  Выберите папку на жестком диске, в которой требуется сохранить 
проект. 

Use folder buttons to
navigate folders and

create new ones

t

r

 
11 Щелкните по кнопке Download (Скачать), чтобы считать проект и сохранить его на жестком диске. 
Примечание: Вы можете записывать проекты в соответствующем формате с жесткого диска в 
запоминающее устройство, используя кнопку с зеленой стрелкой Upload 
 

Use Upload arrow button to
write selected designs from
hard disk to storage device

 
 
 

Выбор закладки 
 
 
Щелчок правой 
кнопкой для 
доступа к 
выпадающему 
меню 

Щелкните для открытия проекта в 
вышивальном ПО BERNINA 
 
 
Щелкните для доступа к свойствам 
проекта 

Выберите 
требуемую 
папку Используйте эти кнопки 

для навигации и 
создания новой папки 
 

Используйте кнопку со 
стрелкой, чтобы передать 
выбранные проекты с 
жесткого диска в 
запоминающее устройство 
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t
b

Запись проектов в память вышивальной машины 
 

Используйте инструмент Write to Machine (панель General), чтобы записать проект в 
память вышивальной машины, на карты памяти или на USB-Stick. 

 
Если вы намерены только вышить проект, когда машина подключена к компьютеру, то следует 
сохранить проект на жестком диске компьютера. Однако вы можете также использовать команду 
Write to Machine (Передать в машину), чтобы сохранить проект для последующего использования 
независимо от ПК. Проекты из любого запоминающего устройства – вышивальной машины, карты 
памяти или USB memory stick – быть затем вышиты в любое время. Таким образом, нет 
необходимости подсоединять компьютер к машине при вышивании проекта. Подробнее см. в 
документации к вашей вышивальной машине BERNINA. 
 
Как записывать проекты в память вышивальной машины 
1  Откройте свой проект и выберите режим просмотра Design View.  
Примечание: Машина (или внешнее устройство считывания/записи 
карт памяти) должна быть включена перед тем, как будет вставлена 
карта памяти, в противном случае проекты не откроются или не 
будут загружены в машину. 
2  Если вы намерены сохранить проект на карте памяти или в USB 
stick, вставьте запоминающее устройство в машину (или модуль 
считывания и записи карт памяти). 
Подробнее о подсоединении см. в инструкции, прилагаемой к устройству считывания и записи 
вышивальных карт памяти. 
3  Щелкните по значку Write to Machine (Передать в машину). 
Если вы загружаете проект в первый раз после включения машины, то появится диалоговое окно 
Device Selection (Выбор устройства). 
 

 
 
4  Выберите тип вышивальной машины и при необходимости последовательный порт. 
5  Нажмите кнопку ОК. 
Если связь с последовательным портом установлена правильно, то появится диалоговое окно Write to 
Embroidery System (Передать в вышивальную систему) и имя и картинка вашего проекта. 
 

Запись в память машины  Запись на карте  Запись на USB-Stick 
 
                
 
 

 
 
 
 
 

 
Кнопка Download для записи    Проект, который будет записан в память машины  

 выбранного проекта 

Выбор типа 
вышивальной 
машины 

Выберите папку, 
которой будет 
сохранен проект 
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b

r

 
6  Выберите требуемое запоминающее устройство, щелкнув по соответствующей кнопке – 
вышивальной машины, карте памяти или USB memory stick. 
Как только вы выберите кнопку, отобразятся все папки и проекты, сохраняемые в 
соответствующем устройстве памяти. 
 
 

 
 
 
 

 
Щелчок правой кнопкой      Создание 
для вызова         новых папок 
всплывающего меню 

 
7  Щелкните по закладке папки, в которой должен быть сохранен проект. 
 
Совет: Используйте кнопки в правой части панели для создания новых папок или навигации по 
структуре папок. Щелкните правой кнопкой по значку проекта для вызова всплывающего меню, 
используемого для переименования, удаления или просмотра свойств проекта. 
 
Примечание: Убедитесь в том, что во время загрузки 
проекта в машину стержень игловодителя находится в 
верхнем положении. 
8  Щелкните по кнопке Download, чтобы загрузить проект. 
Сенсорный дисплей машины во время загрузки проекта остается 
пустым. Проект теперь сохранен в памяти машины. Вы можете 
вышить проект в любое время, не подсоединяя компьютер к вашей 
машине. 
 
Запись проектов непосредственно на USB-Stick 
 

Используйте инструмент Write to Machine (панель General), чтобы записать проект 
непосредственно на USB-Stick. 

 
Проекты можно сохранять на специализированных устройствах BERNINA USB memory stick или 
OESD USB memory stick, подключенных к ПК. Вы можете копировать проекты непосредственно с 
жесткого диска на USB memory stick через MS Windows® Explorer, но для этого нужно пользоваться 
программой BERNINA ART Design Software. При сохранении проекта ПО BERNINA ART Design 
автоматически конвертирует его в правильный формат для вышивки. 
Примечание: Другие типы устройств USB stick также могут быть использованы, но они автоматически 
не распознаются программным обеспечением. 
 
Как записать проект непосредственно на USB stick 
1  Откройте проект и выберите Design View. Подробнее см. в 
разделе Открытие проектов. 
 
 
2  Вставьте BERNINA или OESD USB memory stick непосредственно 
в USB-порт компьютера. 
3  Щелкните по значку Write to Machine (Передать в машину).  
Если вы загружаете проект в первый раз после 
включения машины или модуля считывания карт, то 
появится диалоговое окно Bernina Device Selection 
(Выбор устройства Bernina). 
 

Выбор закладки 
для папок 
 
Выбор папки 
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Совет: Если вы уже подключили вышивальную систему, щелкните по кнопке Connected Device 
(Подключенное устройство) в диалоговом окне Write to Embroidery System (Передать в 
вышивальную систему), чтобы получить доступ к диалоговому окну Bernina Device Selection 
(Выбор устройства Bernina). См. также Передача проектов в машину. 
 

 
 

4  Выберите опцию BERNINA USB Stick и щелкните по OK. 
Если вы вставили устройство USB memory stick, полученное не от BERNINA или OESD, откроется 
диалоговое окно Enter Drive Letter and Path (Ввод буквы привода и пути), предлагающее 
определить место устройства. 
 

 
5  Щелкните, чтобы выбрать путь к устройству USB. 
Если подсоединение выполнено правильно, откроется диалоговое окно Write to Embroidery System 
(Передать в вышивальную систему). На экране появится имя и изображение вашего проекта. 
Будут отображены также папки и проекты, подлежащие сохранению в устройстве. 

 
Щелкните для загрузки  Проект, 
выбранного проекта   подлежащий сохранению 

 
6  Выберите место устройства для сохранения. 
 

Совет: Используйте значки в правой части панели для создания новых папок или перехода по 
структуре папок. Щелкните правой кнопкой по файлам уже сохраненного проекта для вызова 
всплывающего меню, используемого для переименования, удаления или просмотра 
свойств проекта. 
7  Щелкните по кнопке со стрелкой, чтобы записать проект на USB memory stick. 
При сохранении проекта ПО BERNINA ART Design автоматически конвертирует его в правильный 
формат для вышивки. См. соответствующую документацию по ПО BERNINA ART Design для более 
подробной информации о вышивании с USB memory stick. 

Выберите 
BERNINA USB 
Stick 

Щелкните, чтобы перейти к 
диалоговому окну Bernina 
Device Selection 

Щелкните, чтобы выбрать путь 
к устройству USB 

Выберите папку 
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Считывание и запись проектов в MAGIC 
BOX 
Прибор Magic Box ("Волшебная шкатулка") позволяет 
конвертировать файлы, сохраненные в различных "не 
родных" форматах. Вы можете передать проект с карты 
памяти в ПО BERNINA ART Design, отредактировать и 
передать затем на карту Magic Card. Вы сможете 
сохранить проекты с Magic карт в компьютере или 
передать на карту памяти, отличную от Magic Card. 
Примечание: Программное обеспечение Magic Box 
устанавливается автоматически при инсталляции программного пакета BERNINA ART Design и 
работает только с ПО BERNINA ART Design.  
На передней стороне прибора Magic Box имеется четыре прорези для различных карт памяти. 
(Прибор mini Magic Box имеет только прорези 1 и 2.) Цвет прорези соответствует цвету карты Magic 
Card, используемой в этой прорези. 
Используйте прибор Magic Box совместно с BERNINA ART Design для того, чтобы: 

◄ Считать ART-файл с компакт-диска, жесткого диска или дискеты, выполнить требуемые 
изменения и передать файл на карту Magic Card. 

◄ Считать стежковый файл одного из поддерживаемых форматов карт памяти (включая Magic 
Card), выполнить требуемые изменения и передать обратно на карту Magic Card. 

◄ Считать стежковый файл с карты Magic Card, выполнить требуемые изменения и сохранить его 
в запоминающем устройстве по Вашему выбору. 

 
Если проект в формате ПО BERNINA ART Design, вы можете добавить надпись, вставить другие 
проекты, сохраняемые на вашем компьютере, компакт-диске или дискете, используя все функции 
редактирования ПО BERNINA ART Design. 
Приводимые здесь указания применимы только к работе прибора Magic Box с BERNINA ART Design. 
Обратитесь к руководству пользователя прибором Magic Box за указаниями по установке, настройке и 
работе с прибором. 
 

Считывание проектов с карт памяти 
 

Используйте инструмент Read from Magic Box (панель General) для считывания других 
форматов прибором Magic Box. 

 
Вы можете считать проект с любой поддерживаемой карты памяти, отредактировать его и затем 
записать на одну из 4-х карт Magic Card – красную, синюю, желтую или зеленую. Вы можете выбрать 
несколько проектов для записи на карту Magic Card. Однако вы можете передать в ПО BERNINA ART 
Design и редактировать за раз только один проект. 
 
Как считывать проекты с карты памяти 
1  Вставьте карту памяти в Magic Box. Выбранная вами прорезь зависит от формата карты. 
Примечание: Magic Box считает проекты  разных форматов. См. также инструкцию по эксплуатации 
Magic Box. 
 
2  Щелкните по значку Read from Magic Box (Считать с Magic Box). 
Откроется диалоговое окно Magic Box About (О программе Magic Box). 

 
3  Нажмите на ОК, чтобы запустить программу. 
См. также инструкцию по эксплуатации Magic Box. 
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Примечание: Вы можете передать проекты, считанные с Magic Box на дискету или жесткий диск 
компьютера. Вы можете также передать проект на карту памяти, отличную от Magic Card. 
 

Запись проектов на карту Magic Card 

 
Используйте инструмент Write to Magic Box (панель General) для передачи проектов на 
карты Magic Card прибором Magic Box. 

 
Из ПО BERNINA ART Design вы можете передавать проекты в Magic Box, используя карты Magic Card 
в любом из четырех форматов. Используйте карту Magic Card, которая поддерживает нужный вам 
формат. Подробнее см. инструкцию по эксплуатации Magic Box. 
 
Как записывать проекты на карту Magic Card 
1  Загрузите существующий проект с карты памяти в компьютер. 
См. разделы Считывание проектов с карт памяти и Считывание проектов с компьютера. 
Открывается окно «Magic Box About“. 
 

 
2  Нажмите на ОК, чтобы запустить программу. 
Далее см. инструкцию по эксплуатации Magic Box. 
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Приложение А 
 
 
 
 

Клавиатурные команды  
Команды выбираются таким же образом, как и в других приложениях Windows®, – из меню или 
панелей инструментов. Для наиболее часто используемых команд имеются также клавишные 
комбинации быстрого вызова – клавиатурные команды. 
 
Общие функции             Выбор объектов 
 
Чтобы … следует нажать  Чтобы … следует нажать 

   выделить все объекты Ctrl + A 
открыть существующий 
проект  Ctrl + O   отменить выделение всех 

объектов 
Esc или X 

сохранить проект Ctrl + S  активировать инструмент Select 
Object 

клавишу буквы O 

распечатать проект. Ctrl + P  выбрать объект, находящийся 
ниже 

клавишу 2 + 
щелкнуть мышью 

отменить выполненную 
команду Ctrl + Z 

 выбрать несколько объектов клавишу Ctrl +  
щелкнуть мышью 
по объектам 

повторить выполнение 
отмененной команды Ctrl + Y 

 выбрать нескольких 
последовательно расположенных 
объектов 

клавишу Shift + 
щелкнуть мышью 
по первому, а 
затем по 
последнему 
объекту 

отменить команду Esc  выбрать следующий объект Tab 
выйти из программы Alt + F4   выбрать предыдущий объект Shift + Tab 

   добавить следующий по очереди 
объект к выделенным 

Ctrl + Tab 

   добавить предыдущий по очереди 
объект к выделенным 

Ctrl + Shift + Tab 

 
Работа с объектами и стежками 
 
Для того, чтобы … нажать или щелкнуть мышью 
Удалять выбранный 
объект  
 

 Delete 

переместить объект  
 

 перетащить объект мышью 
(drag-and-drop) 

перемещать выделенный 
объект отдельными 
шагами 

 
+ клавиши со  

стрелками ↑ , ↓ , ←  и → 
переместить объект по 
горизонтали и вертикали 
 

 перетащить объект мышью, 
удерживая Ctrl 

сохранить пропорции 
объекта во время 
изменения размеров 

 перетащить угловой маркер, 
удерживая Shift 
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Просмотр проектов 
 
Чтобы … следует 

нажать 
или 

увеличить в 2 раза "B" затем 
щелкнуть 
мышью 

F8 

уменьшить в 2 раза Shift + Z F10 
установить масштаб 1:1 
(100 %) 

1  

показать проект целиком 0 (ноль) F2 
задать  коэффициент 
масштабирования 

F F3 

выровнять по центру 
текущий стежок 

C F6 

вернуться к предыдущему 
экрану просмотра 

V F5 

перерисовать экран R F4 
показать точки прокола 
иглой 

. (запятую или точку) 

показать только 
выделенные объекты 

Shift + S  

измерить M  
 
 
Просмотр последовательности вышивания 
 

следует нажать Чтобы перейти ... 
на основной 
клавиатуре 

на 
цифровой 
панели * 

к началу проекта  Home 7 
к концу проекта  End 1 
к следующему цвету  PageDown 9 
к предыдущему цвету  PageUp 3 
к следующему 
выбранному объекту 

 Tab  

к предыдущему 
выбранному объекту 

 Shift + Tab  

к следующему объекту  Ctrl+T  
к предыдущему объекту  Shift +T  
на 1 стежок вперед †  → 6 
на 1 стежок назад †  ← 4 
на 10 стежков вперед †  ↓ 2 
на 10 стежков назад †  ↑ 8 
на 100 стежков вперед   + 
на 100 стежков назад   - 
активировать 
замедленное 
перерисовавание 

 Shift + R  

* Клавиша Num Lock отключена  
† Функция инструмента Select Object отключена 
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